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Product Description

The Compaq Presario V5000 Notebook PC offers advanced
modularity, Intel® Pentium® M processors, and extensive
multimedia support.

Compagq Presario V5000 Notebook PC
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Product Description

1.1 Features

SN

Numerous references are made throughout this Maintenance and
Service Guide to “full-featured” and “defeatured” computer
models. A model is considered to be full-featured if it has

3 Universal Serial Bus ports and the following components:

PC Card slot
IEEE 1394 port
Memory Reader

A model is considered to be defeatured if it has only 2 Universal
Serial Bus ports and none of the components listed above.

The following processors, varying by computer model:
A Intel Pentium M 2.0- or 1.83-GHz

d Intel Celeron M 1.60-GHz and Intel Celeron 410
1.46-GHz

1 Intel Core Duo T2600 (2.16-GHz), T2250 (1.73-GHz),
T2300E (1.66-GHz), or T2050 1.60-GHz

A Intel Core Solo T1350 (1.86-GHz), 1.83-GHz, or
1.66-Ghz

15.4-inch, WXGA, TFT (1280 x 800) display with antiglare
or BrightView, varying by computer model

120-, 100-, 80-, 60-, or 40-GB high-capacity hard drive,
varying by computer model

256-MB DDR1 synchronous DRAM (SDRAM) at 667 MHz,
expandable to 2.0 GB

Microsoft® Windows® XP Home Edition or Windows XP
Professional, varying by computer model

Full-size Windows keyboard with embedded numeric keypad

TouchPad pointing device, including dedicated horizontal
and vertical scroll regions

1-2
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B Integrated 10Base-T/100Base-TX Ethernet local area
network (LAN) network interface card (NIC) with RJ-45 jack

Integrated high-speed 56K modem with RJ-11 jack

B Integrated wireless support for Mini Card IEEE 802.11a/b/g
WLAN device

Support for one Type I or Type II PC Card slot, with support
for both 32-bit (CardBus) and 16-bit PC Cards

Support for ExpressCard slot

External 65-watt AC adapter with 3-wire power cord
12- or 6-cell Li-Ion battery pack
Stereo speakers

Volume up, volume mute, and volume down buttons

Support for the following optical drives:

[ DVD=RW and CD-RW Super Multi Double-Layer
Combo Drive with LightScribe

d DVD+£RW and CD-RW Super Multi Double-Layer
Combo Drive

1 DVD=RW and CD-RW Double-Layer Combo Drive with
LightScribe and Hitachi LG Data Storage

1 DVD+RW and CD-RW Double-Layer Combo Drive with
LightScribe

1 DVD/CD-RW Double-Layer Combo Drive with
LightScribe

DVD/CD-RW Combo Drive
d DVD-ROM drive

C
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B Connectors:

a

o000 0 ddUd4doOdoo

Audio-in (microphone)
Audio-out (headphone)
Memory Reader (select models only)
Expansion port 2

ExpressCard slot

External monitor

IEEE 1394 (select models only)
PC Card (select models only)
Power

RJ-11 (modem)

RJ-45 (network)

S-Video-out

Universal Serial Bus (USB) v. 2.0 (2 or 3 ports, varying by
computer model)

1.2 Resetting the Computer

If the computer you are servicing has an unknown password,
follow these steps to clear the password. These steps also
clear CMOS:

1. Prepare the computer for disassembly (refer to Section 5.3,
“Preparing the Computer for Disassembly,” for more
information.)

2. Remove the real-time clock (RTC) battery (refer to Section
5.8, “RTC Battery,” for more information.)

1-4
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Product Description

3. Wait approximately 5 minutes.
4. Replace the RTC battery and reassemble the computer.

5. Connect AC power to the computer. Do not reinsert any
battery packs at this time.

6. Turn on the computer.

All passwords and CMOS settings have been cleared.

1.3 Power Management

The computer comes with power management features that
extend battery operating time and conserve power. The
computer supports the following power management features:

Standby

Hibernation

Setting customization by the user

Hotkeys for setting the level of performance
Battery calibration

Lid switch standby/resume

Power button

Advanced Configuration and Power Management (ACPM)
compliance
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1.4 External Components

The external components on the front of the computer are shown
below and described in Table 1-1.

Front Components
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Table 1-1
Front Components
Item Component Function
1 Power light B On: Computer is turned on.

B Off: Computer is off or in hibernation.
B Blinking: Computer is in standby.

2 Battery light B On: A battery pack is charging or is close
to full charge capacity.

W Off: If the computer is plugged into an
external power source, the light is turned
off when all batteries in the computer are
fully charged. If the computer is not
plugged into an external power source,
the light stays off until the battery
reaches a low-battery condition.

B Blinking: A battery pack that is the only
available power source has reached a
low-battery condition. When the battery
reaches a critical low-battery condition,
the battery light begins blinking quickly.

3 Drive light On or blinking: The internal hard drive or an
optical drive is being accessed.

4 Speakers Produce stereo sound.

5 Display release button  Opens the computer.
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The external components on the right side of the computer are
shown below and described in Table 1-2.

Right-Side Components

Table 1-2
Right-Side Components
Item Component Function
1 Audio-out Connects an optional headphone or
(headphone) jack powered stereo speakers. Also connects
the audio function of an audio/video device,
such as a television or VCR.
2 Audio-in (microphone)  Connects an optional stereo microphone.
jack
3 ExpressCard slot Supports an optional ExpressCard.
4 USB port Connects optional USB devices.
(select models only)
5 Optical drive Supports an optical disc, such as a CD or
DVD.
6 RJ-11 (modem) jack Connects a modem cable (not included).
7 Power connector Connects the AC adapter cable.

1-8
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The external components on the rear panel of the computer are
shown below and described in Table 1-3.

Rear Panel Components

Table 1-3
Rear Panel Components
Item Component Function
1 Battery bay Holds a battery pack.
2 Vent Provides airflow to cool internal
components.

A To prevent overheating, do not
obstruct vents. Do not allow a hard
surface, such as a printer, or a soft
surface, such as pillows or thick rugs
or clothing, to block airflow.
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The external components on the left side of the computer are
shown below and described in Table 1-4.

Left-Side Components

Table 1-4
Left-Side Components
Item Component Function
1 Security cable slot Attaches an optional security cable to the
computer.

The security cable is designed to act
as a deterrent, but may not prevent
the computer from being mishandled

or stolen.
2 Monitor port Connects an optional VGA monitor or
projector.
3 S-Video-out jack Connects the video function of an optional

S-Video device, such as a television, VCR,
or video capture card.
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Table 1-4
Left-Side Components (Continued)
ltem  Component Function
4 RJ-45 (network) jack Connects a network cable (not included).
5 Expansion port 2 Connects the computer to an optional
expansion product.
The computer has only one
expansion port. The term expansion
port 2 describes the type of
expansion port.
6 USB ports (2) Connect optional USB devices.
7 1394 port Connects an optional 1394a device such as
(select models only) a scanner, a digital camera, or a digital
camcorder.
8 Memory Reader light On: An optional digital card is being
(select models only) accessed.
9 Memory Reader Supports the following optional digital
(select models only) cards: Secure Digital (SD) Memory Card,
SD I/O Card, Memory Stick, Memory Stick
Pro, MultiMediaCard, xD-Picture Card, and
SmartMedia.
10 PC Card slot Supports an optional Type | or Type Il

(select models only)

32-bit (CardBus) or 16-bit PC Card.
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The standard keyboard components of the computer are shown
below and described in Table 1-5.
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Table 1-5
Standard Keyboard Components
Item Component Function
1 f1 to f12 keys (12) Perform system and application tasks.
When combined with fn, function keys
perform additional tasks as hotkeys.
2 caps lock key Enables caps lock and turns on the
caps lock light.
3 fn Combines with other keys to perform
key system tasks as hotkeys. For example,
pressing fn+f7 decreases screen
brightness.
4 Windows logo key Displays the Microsoft Windows Start
menu.
5 Windows Displays a shortcut menu for items
applications key beneath the pointer.
6 Arrow keys Move the cursor around the screen.
7 Numeric keypad keys Can be used like the keys on an external
(15) numeric keypad.
8 num lock key Enables numeric lock, turns on the

embedded numeric keypad, and turns
on the num lock light.
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The computer top components are shown below and described in
Table 1-6.

Top Components
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Table 1-6

Top Components

Item

Component

Function

caps lock light

On: Caps lock is enabled.

Wireless button

Turns the wireless functionality on or off,
but does not create a wireless connection.

To establish a wireless connection,
a wireless network must already be
set up.

Power button

When the computer is

B Off, press to turn on the computer.

M On, press to enter hibernation.

B In standby, briefly press to exit standby.

W In hibernation, briefly press to exit
hibernation.

If the computer has stopped responding
and Microsoft® Windows® shutdown
procedures cannot be used, press and
hold the power button for at least

5 seconds to turn off the computer.

Volume down button

Decreases speaker volume.

Volume up button

Increases speaker volume.

Volume mute button

Mutes or restores speaker volume.

N ol o M

num lock light

On: Num lock is enabled.
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The computer TouchPad components are shown below and
described in Table 1-7.

TouchPad Components
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Table 1-7

TouchPad Components

Item Component

Function

1 TouchPad Moves the pointer and selects or activates
items on the screen. Can be set to perform
other mouse functions, such as scrolling,
selecting, and double-clicking.
2 TouchPad horizontal Scrolls left or right.
scroll zone

3 Left and right Function like the left and right buttons on
TouchPad buttons an external mouse.

4 TouchPad vertical Scrolls up or down.
scroll zone
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The external components on the bottom of the computer are
shown below and described in Table 1-8.

Bottom Components

Table 1-8
Bottom Components

Item Component Function

1 Optical drive Supports an optical disc, such as a CD
or DVD.

2 Labels area Contains the serial number and other
information labels.

3 Battery pack release latch  Releases a battery pack from the
battery bay.

4 Battery bay Holds a battery pack.
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Table 1-8
Bottom Components (Continued)
Item Component Function
5 Vents (2) Provide airflow to cool internal
components.

A To prevent overheating, do not
obstruct vents. Do not allow a
hard surface, such as a printer, or
a soft surface, such as pillows
or thick rugs or clothing, to block

airflow.
6 Memory/Mini Card module M Contains 2 memory module slots that
compartment cover support replaceable memory

modules. The number of preinstalled
memory modules varies by computer
model.

B Holds an optional wireless LAN
device (select models only).

A To prevent an unresponsive
system and the display of a
warning message, install only a
Mini Card device authorized for
use in your computer by the
governmental agency that
regulates wireless devices in
your country. If you install an
unauthorized device and then
receive a warning message,
remove the device to restore
computer functionality. Then
contact Customer Care.

7 Hard drive bay Holds the internal hard drive.
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1.5 Design Overview

This section presents a design overview of key parts and features
of the computer. Refer to Chapter 3, “Illustrated Parts Catalog,”
to identify replacement parts, and Chapter 5, “Removal and
Replacement Procedures,” for disassembly steps.

The system board provides the following device connections:

Intel Pentium M processors
Audio

Digital media card
Display
ExpressCard

Hard drive
Keyboard
Memory module
Mini Card devices
PC Card
TouchPad

CAUTION: To properly ventilate the computer, allow at least a 7.6-cm
(3-inch) clearance on the left and right sides of the computer.

The computer uses an electric fan for ventilation. The fan is
controlled by a temperature sensor and is designed to turn on
automatically when high temperature conditions exist. These
conditions are affected by high external temperatures, system
power consumption, power management/battery conservation
configurations, battery fast charging, and software. Exhaust air is
displaced through the ventilation grill located on the left side of
the computer.

1-20
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Troubleshooting

WARNING: Only authorized technicians trained by HP should repair
this equipment. All troubleshooting and repair procedures are detailed
to allow only subassembly-/module-level repair. Because of the
complexity of the individual boards and subassemblies, do not attempt
to make repairs at the component level or modifications to any printed
wiring board. Improper repairs can create a safety hazard. Any
indication of component replacement or printed wiring board
modification may void any warranty or exchange allowances.

Computer Setup

Computer Setup is a system information and customization utility
that can be used even when the operating system is not working
or will not load. This utility includes settings that are not
available in Windows.

Using Computer Setup

Information and settings in Computer Setup are accessed from
the File, Security, Diagnostics, or System Configuration menus:

1. Turn on or restart the computer. Press f10 while the
F10 = ROM-Based Setup message is displayed in
the lower-left corner of the screen.

[ To change the language, use the cursor control keys
to navigate to the System Configuration menu.

d To view navigation information, press f1.

[ To return to the Computer Setup menu, press €sc.
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2. Select the File, Security, Diagnostics, or
System Configuration menu.

3. To close Computer Setup and restart the computer:
[ Select File > Save changes and exit, and then press enter.

[ Select File > Ignore changes and exit, and then
press enter.

[ Select File > Restore defaults, and then press enter.

4. When you are prompted to confirm your action, press f10.

Selecting from the File Menu

Table 2-1
File Menu
Select To Do This
System Information B View identification information about the

computer, processor, memory and cache size,
and system ROM.

B View BIOS revision, keyboard controller
version, and battery pack serial number
information.
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Selecting from the Security Menu

Table 2-2

Security Menu

Select

To Do This

Setup Password

Enter, change, or delete an Setup password.

Power-On Password

Enter, change, or delete a power-on password.

Password Options
(Password options can
be selected only when
a power-on password
has been set.)

Enable/disable
B Stringent security.
B Requirement of password on restart.

DriveLock Passwords

Enable/disable DriveLock; change a DriveLock
user or master password.

DriveLock Settings are accessible only
when you enter Computer Setup by turning
on (not restarting) the computer.

Smart Card Security

Enable/disable smart card power-on support.

A setup password must be established to
use this feature.

TPM Embedded Security

Enable/disable

B Embedded security device state.
B Power-on authentication support.
B Automatic DriveLock support.

System IDs

Establish
B Notebook asset tracking number.
B Notebook ownership tags.

Disk Sanitizer

Establish fast, optimum, or custom settings for
disk sanitizing.

*Not applicable to SuperDisk LS-120 drives.
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Selecting from the Diagnostics Menu

Table 2-3

Diagnostics Menu

Select To Do This

HDD Self-Test Options Run a quick comprehensive self test on hard
drives in the system that support the test features.

Memory Check Run a quick comprehensive test on system
memory on the following categories:

B Walking Os
B Walking 1s
B High Address line testing
B Alternate Pattern testing
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Selecting from the System
Configuration Menu

Table 2-4

System Configuration Menu

Select

To Do This

Language

Change the Computer Setup language.

Boot Options

Enable/disable MultiBoot, which sets a startup
sequence that can include most bootable devices
and media in the system.

Device Configurations

Enable/disable

B Swap Fn/Ctrl keys.

B USB legacy support.

B BIOS DMA data transfers.

B Fan Always on while on AC Power.
B Data Execution Prevention.

B LAN Power save.

Built-In Device Options

Enable/disable

B Embedded WLAN Device Radio.

B Embedded Bluetooth Device Radio.
B LAN/WLAN Switching.

B Wake on LAN from Off.

Port Options

Enable/disable
B USB Port.

B 1394 Port.

B CardBus Slot.
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2.2 Troubleshooting Flowcharts

Table 2-5

Troubleshooting Flowcharts Overview

Flowchart Description

21 “Flowchart 2.1—lInitial Troubleshooting”

2.2 “Flowchart 2.2—No Power, Part 1”

2.3 “Flowchart 2.3—No Power, Part 2”

2.4 “Flowchart 2.4—No Power, Part 3”

2.5 “Flowchart 2.5—No Power, Part 4”

2.6 “Flowchart 2.6—No Video, Part 1”

2.7 “Flowchart 2.7—No Video, Part 2”

2.8 “Flowchart 2.8—Nonfunctioning Docking Device (if applicable)”
29 “Flowchart 2.9—No Operating System (OS) Loading”
2.10 “Flowchart 2.10—No OS Loading, Hard Drive, Part 1”
2.11 “Flowchart 2.11—No OS Loading, Hard Drive, Part 2”
2.12 “Flowchart 2.12—No OS Loading, Hard Drive, Part 3”
2.13 “Flowchart 2.13—No OS Loading, Diskette Drive”
2.14 “Flowchart 2.14—No OS Loading, Optical Drive”
2.15 “Flowchart 2.15—No Audio, Part 1”

2.16 “Flowchart 2.16—No Audio, Part 2”

217 “Flowchart 2.17—Nonfunctioning Device”

2.18 “Flowchart 2.18—Nonfunctioning Keyboard”

219 “Flowchart 2.19—Nonfunctioning Pointing Device”
2.20 “Flowchart 2.20—No Network/Modem Connection”
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Flowchart 2.1 —Initial Troubleshooting

Begin
troubleshooting.

Is there
power?

Go to
“Flowchart
2.2—No Power,
Part 1

Beeps,
LEDs, or error
messages?

Check
LED board,
speaker
connections.

Is there video?
(no boot)

Goto
| “Flowchart
2.6—No Video,
Part1”

Is the 0S
loading?

Go to
“Flowchart
2.9—No Operating
System (OS)

Loading”

Is there
sound?

Goto
| “Flowchart
2.15—No Audio,

Part 1”

All drives
working?

Keyboard/
pointing
device
working?

Connecting
to network
or modem?

Goto
“Flowchart
2.17—Nonfunc-
tioning Device.”

Go to
“Flowchart
2.18—Nonfunc-
tioning Keyboard”
or “Flowchart
2.19—Nonfunc-
tioning Pointing
Device.”

Go to
“Flowchart
2.20—No
Network/Modem
Connection.”
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Flowchart 2.2—No Power, Part 1

No power
(power LED

is off).

L]

Remove from
docking device
(if applicable).

1. Reset the power cables in the docking device
and at the AC outlet.

2. Be sure the AC power source is active.

3. Be sure that the power strip is working.

Power up
in docking
device?

Done

Power u Goto
p Reset Power up “Flowchart
on battery s ower* on battery 23 No P
power? power. power? : _Parot 2?,‘”6“
N
Goto
) power.* p ’ 2.4—No Power,
power? Part 3”
Power up in
docking - Done *NOTES
device? 1. On select computer models, there is a

separate reset button.

2. On select computer models, the computer
can be reset using the standby switch and
either the lid switch or the main power
switch.

Go to
“Flowchart
-2.8—Nonfunctioning
Docking Device (if
applicable).”
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Flowchart 2.3—No Power, Part 2

Continued from
“Flowchart
2.2—No Power,
Part 1.

L]

Visually check for
debris in battery
socket and clean

if necessary.
Y
Power on? Done
N
Check battery pack
by
recharging it,
moving it to
another computer,
N
Replace
Power on? power supply
(if applicable).
Y
N
Goto
“Flowchart
Done Power on? 2.4—No Power,
Part 3”

Done
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Flowchart 2.4—No Power, Part 3

Continued from
“Flowchart
2.3—No Power,
Part2”

Plug directly
into AC outlet.

Power LED

on? Done
Reseat AC adapter
in computer and
at power source.
Power on? Done
External
Internal or
Power outlet Try different external AC Reglgt;e(zj:;}g;nal
active? outlet. adapter? :
Internal N
Go to
“Flowchart | P ?
Replace ower on?
2.5—No Power,
power cord. Part 4"
Y
Y
Done
Power on? H Done
N
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Flowchart 2.5—No Power, Part 4

Continued from
“Flowchart
2.4—No Power,
Part 3”

Y

Open
computer.

Loose or
damaged
parts?

Reseat loose
components and
boards and
replace damaged
items.

Replace the following items (if applicable). Check
computer operation after each replacement:

1. Internal DC-DC converter*

2. Internal AC adapter

3. Processor board*

4. System board*

*NOTE: Replace these items as a set to prevent
shorting out among components.

N

Close
computer and
retest.
N
Power on?

Y

Done
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Flowchart 2.6—No Video, Part 1

No video.

Docking Device

Go to
Stand-alpne “Flowchart
or docking [ 2.7—No Video,
device? Part 2

Stand-alone

Internal or
external
display*?

Adjust
brightness.

External Internal

Al

Adjust
brightness.

- Done

Video OK?

*NOTE: To change from internal to
external display, use the hotkey
combination.

Video OK? s Done

AJ
Press lid
switch to ensure
operation.

Video OK? L Done

Check for bent

. 2. Displa;
pins on cable. peay

3. System board

Replace the following one at a time. Tesf after each replacement.
1. Cable between computer and computer display (if applicable)

Try
- another
display.

Video OK?

Internal and Replace
external - system
video OK? board.
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Flowchart 2.7—No Video, Part 2

Continued from
“Flowchart
2.6—No Video,
Part 1
Remove
computer from
docking device,
if connected.
Adjust Check brightness
display of external
brightness. monitor.
Go to “A” in
; “Flowchart ;
? ?
Video OK? 2.6—No Video, Video OK? Done
Part 1”
Check that computer is properly Try another
seated in docking device, for external
bent pins on cable, and for monitor.
monitor connection. ’
Y
Internal
Video 0K? Done and external Done
video OK?
N
G(; to
Adjust external “Flowchart
monitor display. 2.8—Nonfunctioning
Docking Device (if
v applicable).”
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Flowchart 2.8 —Nonfunctioning Docking Device
(if applicable)

Nonfunctioning
docking device.

L]

Reset power cord in
docking device and
power outlet.

Y

Check voltage
setting on docking
device.

L] Y

Reset monitor
cable connector at
docking device.

Reinstall
computer into
docking device.

Y Y

Docking
device
operating?

Docking
device
operating?

- Done

H Done

: Test replacement
Repl%%?ligg(:kmg docking device with
' new computer.
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Troubleshooting

Flowchart 2.9—No Operating System (OS)

Loading

No 0S
loading.”

y

Reset power
cord in docking
device and
power outlet.

No OS loading from hard drive,
go to “Flowchart 2.10—No OS Loading,
Hard Drive, Part 1

No 0S loading from diskette drive,
go to “Flowchart 2.13—No OS Loading,
Diskette Drive.

No 0S loading from CD-ROM or DVD-ROM
drive, go to “Flowchart 2.14—No OS
Loading, Optical Drive.

No 0S loading from network,
go to “Flowchart 2.20—No Network/Modem
Connection.”

*NOTE: Before beginning troubleshooting, always
check cable connections, cable ends, and drives
for bent or damaged pins.
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Troubleshooting

Flowchart 2.10—No OS Loading, Hard Drive,
Part 1

0S not
loading from
hard drive.

Y Goto

Nonsystem “Flowchart
disk message? 2.11—No OS
Loading,

Hard Drive, Part 2

Res'eat
external
hard drive.

0S loading?

Done

B Go to
\ frg(rﬁ “Flowchart
Check the Setup diskette? 2.1L302é\ilr? 0s
utility for correct Diskon Dg_, .
booting order. Y iskette Drive.

Change boot

priority through

fBrg(r); the Setup Utility
hard drive? et

i Boot Goto
from “Flowchart
hard drive? 2.17—Nonfunctioning
Done Device.”
Y
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Troubleshooting

Flowchart 2.11—No OS Loading, Hard Drive,

Part 2

Continued from
“Flowchart
2.10—No OS
Loading,
Hard Drive, Part 1

CD or
diskette in
drive?

-

1. Replace
hard drive.

2. Replace system
board.

Remove
diskette and
reboot.

Boot
from
hard drive?

- Done

N
Go to
Boot “Flowchart
from diskette - 2.13—No OS
drive? Loading,

Diskette Drive.”

Hard drive

Reseat
hard drive.

Hard drive
accessible?

Done

\J

Run FDISK.

Hard drive
partitioned?

Create partition,

and then format

hard drive to -
bootable

C:\ prompt.

Hard drive
formatted?

Format hard drive
and bring to
a bootable
C:\ prompt.

Y

accessible?

Goto
“Flowchart
2.12—No 0OS
Loading,
Hard Drive, Part 3”

Computer

Done

booted?

Load OS using
Operating System
disc (if applicable).

Go to
“Flowchart
2.12—No OS
Loading,
Hard Drive, Part 3
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Troubleshooting

Flowchart 2.12—No OS Loading, Hard Drive,

Part 3

Continued from
“Flowchart
2.11—No OS
Loading,
Hard Drive, Part 2

System

files on hard
drive?

Install 0S
and reboot.

Y
Virus 0S
on ; .
) Clean virus. loading from Done
hard drive? hard grive?
Run SCANDISK and
check for Diagnostics Replace
bad sectors. on diskette? hard drive.
N
Can bad Replace Run diagnostics
sectors hard drive and follow
be fixed? ' recommendations.
Y
Fix bad Boot fr_Om Rep|ace
sectors. hard drive? hard drive.
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Troubleshooting

Flowchart 2.13—No OS Loading, Diskette Drive

Done

device?

tioning Device.”

Install bootable
diskette and
reboot computer.

0S not loading Reseat 0S
from - i ing? i
diskette drive. diskette drive. loading?
Nonsystem %?:lzgaf
disk message? in drive? i
Y
Check diskette
Go to for system files.
Boot “Flowchart Try different
from another ™ 5 17—Nonfunc- diskette.

Nonsystem

1. Replace diskette
drive.

2. Replace system
board.

Done

the Setup Utility.

2.17—Nonfunctioning

Device.”

i disk error?
d _Dlskettg,l d Enable drive
iﬂvtﬁ: g%tuep and cold boot
Utility? computer.
Y
0S
Reset the computer. . L
Is diskette Refer to loading?
drive boot Section 1.2,
order “Resetting the
correct? Computer,” for
N instructions.
Goto
Change boot B
priority using Flowchart
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Troubleshooting

Flowchart 2.14—No OS Loading, Optical Drive

No 0S Install bootable
loading from Disc Bootable disc and
CD-ROM or in drive? disc in reboot
DVD-ROM drive. | drive? computer.
Install Try another
bootable disc. bootable disc.
Boots from
CD or DVD? Done
Reseat Boots from
drive. CD or DVD? Done
. B°°ti"?h “Flgv(\)/;(r)mart
rogl qno? er 2.17—Nonfunctioning
evice? Device.”
Reset the computer.
; Refer to Go to
B[()Jrodtg:g Section 1.2, | “Flowchart
correct? “Resetting the 2.17—Nonfunctioning

Computer,” for
instructions.

Device.”

Correct boot
order using
the Setup Utility.
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Troubleshooting

Flowchart 2.15—No Audio, Part 1

Turn up audio

No audio. | internally or - Done
externally.
Y
i Goto
Computer in .
docking device Undock '25%222' »2 16FIochh/;a\rEj _
(if applicable)? ! . ;’1 rt02 \udio,
N
Goto
“Flowchart Retphlgce
2.16—No Audio, . .
Part 2 docking device.
Go to
“Flowchart
2.17—Nonfunctioning i Done
Device.”
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Troubleshooting

Flowchart 2.16—No Audio, Part 2

Continued from
“Flowchart
2.15—No Audio,
Part 1”

Y

Audio
driver in 0S
configured?

Reload
audio drivers.

Correct Load drivers and
drivers for - set configuration
application? in 0S.
Y
Connect to
external
speaker.
N Replace audio Y
board and
speaker
connections i pone
in computer
Y (if applicable). N

1. Replace internal speakers.
| 2. Replace audio board (if applicable).
3. Replace system board.
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Troubleshooting

Flowchart 2.17 —Nonfunctioning Device

Nonfunctioning
device.

L]

Reseat
device.

L]

Unplug the nonfunctioning device from the computer
and inspect cables and plugs for bent or broken pins or
other damage.

Clear
CMOS.

Any physical
device detected?

v

Reattach device.
Close computer,
plug in power,
and reboot.

Replace hard drive.

Device

Replace NIC.
If integrated NIC,

Fix or
replace
broken item.

Go to
“Flowchart
2.9—No
Operating System
(OS) Loading”

Device

boots —1 — boots
properly? replabc:a?gstem properly?
Y Y
Done > Replag;ei \gskette > Done
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Troubleshooting

Flowchart 2.18 —Nonfunctioning Keyboard

Keyboard
not operating
properly.

L]

Connect computer
to good external
keyboard.

Y

External Replace
device system
works? board.

Reseat internal
keyboard
connector

(if applicable).

Replace internal
keyboard or
cable.

=

Done Done

Z

Replace
system
board.
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Troubleshooting

Flowchart 2.19—-Nonfunctioning Pointing
Device

Pointing device
not operating
properly.

Y

Connect computer
to good external
pointing device.

External Replace
device system
works? board.

Reseat internal
pointing device
connector
(if applicable).

N

Replace internal
pointing device
or cable.

=

Done " Done

z

Replace
system
board.
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Troubleshooting

Flowchart 2.20—No Network/Modem
Connection

No network
or modem
connection.

Network
or modem jack
active?

Replace jack
or have jack
activated.

Y
o Connect
Digital
”'gé? to nondigital
line.
N
Y
Reload
l\élg,r{%(zdr(é? drivers and i Done
in 0S? reconfigure.
Y N
power o NCmodern
the computer (if ap;Tligaglne])
and open. '
v Y
Reseat NI_C/modem
(if applicable). Done
I N
Replace
system
board.
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3

lllustrated Parts Catalog

This chapter provides an illustrated parts breakdown and a
reference for spare part numbers.

3.1 Serial Number Location

When ordering parts or requesting information, provide the
computer serial number and model number located on the bottom
of the computer.

Serial Number Location
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lllustrated Parts Catalog

3.2 Computer Major Components

Computer Major Components
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lllustrated Parts Catalog

Table 3-1
Spare Parts: Computer Major Components
Spare Part
Item  Description Number
1 Display assembilies (include display cable, wireless antenna boards,
and antenna cables)
For use with UMA system boards
15.4-inch, WXGA with BrightView 430530-001
15.4-inch, WXGA with antiglare 430531-001
For use with discrete system boards
15.4-inch, WXGA with BrightView 407842-001
15.4-inch, WXGA with antiglare 407840-001

Refer to Section 3.3, “Display Assembly Subcomponents,” for
display assembly internal component spare part number

information.
2 Switch cover 407827-001
3 Keyboards
Denmark 407856-081 Saudi Arabia 407856-171
France 407856-051 Spain 407856-071
French Canada 407856-121 Sweden/Finland 407587-B71
International 407856-B31  Thailand 407856-281
Italy 407856-061  The United 407856-031
Korea 407856-AD1 Kingdom
Latin America 407856-161  The United 407856-001
Norway 407856-091 States
4 Top covers
For use with full-featured computer models 407824-001
For use with defeatured computer models 407823-001
TouchPad bracket (not illustrated) 407812-001
Display release button assembly (not illustrated) 407861-001
5 LED board (includes LED board cable) 409071-001
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Computer Major Components
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lllustrated Parts Catalog

Table 3-1

Spare Parts: Computer Major Components (Continued)

Spare Part
Item  Description Number
Cable Kit 407775-001
Includes:
6a Bluetooth module cable
6b USB/audio board cable
6¢c Power connector and cable
6d Modem connector and cable
7 Bluetooth® module (includes Bluetooth 397922-001

module cable)

8 Optical drives

DVD+RW and CD-RW Double-Layer Combo Drive 417699-001
with LightScribe and Hitachi LG Data Storage

DVD+RW and CD-RW Super Multi Double-Layer 430210-001
Combo Drive with LightScribe

DVD+RW and CD-RW Super Multi Double-Layer 430212-001
Combo Drive

DVD+RW and CD-RW Double-Layer Combo Drive 430211-001

DVD/CD-RW Combo Drive 430208-001
DVD-ROM drive 430209-001
9 PC Card assembly 407829-001
10 ExpressCard assembly 407809-001
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Computer Major Components
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lllustrated Parts Catalog

Table 3-1

Spare Parts: Computer Major Components (Continued)

Spare Part
Item Description Number
11 Plastics Kit 407779-001
Includes:
11a PC Card slot bezel
11b ExpressCard slot bezel
11c Hard drive cover (includes 2 captive screws)
11d Memory/Mini Card module compartment cover
(includes 2 captive screws)
Computer feet (8, not illustrated)
12 Expansion port 2 bracket 407863-001
13 System boards
945GM for use with full-featured computer models 430198-001
940GML for use with defeatured computer models 430199-001
14 Processors (include thermal paste)
Intel Pentium M 2.0-GHz 407762-001
Intel Pentium M 1.83-GHz 407761-001
Intel Celeron 1.60-GHz 430202-001
Intel Celeron 410 1.46-GHz 430849-001
Intel Core Duo T2600 2.16-GHz 430847-001
Intel Core Duo T2250 1.73-GHz 430851-001
Intel Core Duo T2300E 1.66-GHz 430848-001
Intel Core Duo T2050 1.60-GHz 430850-001
Intel Core Solo T1350 1.86-GHz 430852-001
Intel Core Solo 1.83-GHz 430200-001
Intel Core Solo 1.66-Ghz 430201-001
15 Fan assembly (includes thermal paste) 409073-001
Heat sink assembly (includes thermal paste) 403827-001
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Computer Major Components
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lllustrated Parts Catalog

Table 3-1

Spare Parts: Computer Major Components (Continued)

Spare Part

Item Description Number
16 USB/audio board (includes USB/audio board cable) 409078-001
17 Speakers 407785-001
18 Base enclosure 407815-001
19 Battery packs

12-cell, 8.8-Amp hour 407835-001

6-cell, 4.0-Amp hour 407834-001
20 Hard drives (include frame and connector)

5400 rpm, 120-GB 430329-001

5400 rpm, 100-GB 409064-001

5400 rpm, 80-GB 409063-001

5400 rpm, 60-GB 409062-001

5400 rpm, 40-GB 409061-001
21 Memory modules, 1-DIMM

PC2-5300

1024 MB 409060-001

512 MB 409059-001

256 MB 409058-001

SD Memory Cards (no illustrated)

512 MB 407316-001

256 MB 403573-001
22 RTC battery (includes 2-sided tape) 407816-001
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Computer Major Components
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lllustrated Parts Catalog

Table 3-1
Spare Parts: Computer Major Components (Continued)
Spare Part
Item Description Number
23 Mini Card modules
802.11a/b/g WLAN module for use in the countries 407576-001
listed below. These countries are categorized as
most of the world (MOW) 1.
Antigua & Canada Panama Paraguay
Barbuda Chile India Saudi Arabia
Argentina Dominican Indonesia Taiwan
Australia Republic Malaysia The United
Bahamas Guam Mexico States
Barbados Guatemala New Zealand Vietnam
Brunei Hong Kong
802.11a/b/g WLAN module for use in the countries 407576-002
listed below. These countries are categorized as
most of the world MOW 2.
Aruba El Salvador Poland Norway
Austria Estonia Portugal Oman
Azerbaijan Finland Romania Slovenia
Bahrain France Russia South Africa
Belgium Georgia Serbia and Spain
Bermuda Germany Montenegro Sri Lanka
Bulgaria Greece Singapore Sweden
Cayman Islands  Hungary Slovakia Switzerland
Columbia Iceland Liechtenstein Turkey
Croatia Ireland Lithuania The United
Cyprus Italy Luxembourg Kingdom
Czech Republic  Latvia Malta Uzbekistan
Denmark Lebanon Monaco
Egypt The The Netherlands
Philippines
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Computer Major Components

3-12 Maintenance and Service Guide



lllustrated Parts Catalog

Table 3-1

Spare Parts: Computer Major Components (Continued)

Spare Part
Item Description Number
23 Mini Card modules (Continued)
802.11a/b/g WLAN module for use in the countries 407576-003
listed below. These countries are categorized as the
rest of the world ROW.
China Honduras Qatar Uruguay
Ecuador Pakistan South Korea Venezuela
Haiti Peru
802.11b/g WLAN module for use in the MOW1 407107-001
countries listed below:
Antigua & Canada Panama Paraguay
Barbuda Chile India Saudi
Argentina Dominican  Indonesia Arabia
Australia Republic Malaysia Taiwan
Bahamas Guam Mexico The United
Barbados Guatemala  New Zealand States
Brunei Hong Kong Vietnam
802.11b/g WLAN module for use in the ROW countries ~ 407107-002
listed below:
China Honduras Qatar Uruguay
Ecuador Pakistan South Korea Venezuela
Haiti Peru
802.11b/g WLAN module for use in the following 409250-004
countries:
Jordan Kuwait United Arab Ukraine
Israel Thailand Emirates
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3.3 Display Assembly Subcomponents
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lllustrated Parts Catalog

Table 3-2
Display Assembly Subcomponents

Spare Part Number Information

Item  Description

Display Plastics Kit, includes: 407793-001
1a W Display bezel
1b W Display enclosure
2 Display Hinge Kit 407797-001
3 Display inverter board 407800-001
4 Display Panel Kit (includes display panel cable)
15.4-inch, WXGA with BrightView 407799-001
15.4-inch, WXGA antiglare 407798-001
5 Wireless Antenna Kit (includes cable, transceivers, 410118-001
and tape)
Display Label Kit (not illustrated) 430216-001
Display Cable Kit (not illustrated) 430533-001
Display Screw Kit (not illustrated), includes: 407795-001

B Phillips PM2.5x7.0 screws
B Phillips PM2.0x4.0 screws
B Rubber screw covers
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lllustrated Parts Catalog

3.4 Plastics Kit

o_
_o

Table 3-3
Plastics Kit

Spare Part Number Information

Spare Part
Item  Description Number
Plastics Kit, includes: 407779-001
1 Memory/Mini Card module compartment cover (includes 2 captive
screws, secured by C-clips)
2 Hard drive cover (includes 2 captive screws, secured by C-clips)
3 Computer feet for use on base enclosure (8)
4 ExpressCard slot bezel
5 PC Card slot bezel

3-16
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lllustrated Parts Catalog

3.5 Cable Kit

i —

o = o
_o
_o

Table 3-4
Cable Kit
Spare Part Number Information
Spare Part
Item  Description Number
Cable Kit, includes: 407775-001

—_

TouchPad cable
Bluetooth module cable
USB/audio board cable

Modem connector cable

a ~ O DN

Power connector cable
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lllustrated Parts Catalog

3.6 Mass Storage Devices
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lllustrated Parts Catalog

Table 3-5
Mass Storage Devices

Spare Part Number Information

Spare Part
Item Description Number
1 Hard drives (include frame and connector)
5400 rpm, 120-GB 430429-001
5400 rpm, 100-GB 409064-001
5400 rpm, 80-GB 409063-001
5400 rpm, 60-GB 409062-001
5400 rpm, 40-GB 409061-001
2 Optical drives

DVD+RW and CD-RW Double-Layer Combo Drive 417699-001
with LightScribe and Hitachi LG Data Storage

DVD+RW and CD-RW Super Multi Double-Layer 430210-001

Combo Drive with LightScribe

DVD+RW and CD-RW Super Multi Double-Layer 430212-001

Combo Drive

DVD+RW and CD-RW Double-Layer Combo Drive 430211-001

DVD/CD-RW Combo Drive 430208-001

DVD-ROM drive 430209-001
USB digital drive (not illustrated) 364727-001
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lllustrated Parts Catalog

3.7 Miscellaneous (Not lllustrated)

Table 3-6
Miscellaneous (Not lllustrated)

Spare Part Information

Spare Part
Description Number
Analog TV tuner 407941-001
Composite S-Video and audio cable 407939-001
DVB-T TV tuner 412175-001
DVB-T TV tuner antenna 412176-001
HP Remote Control I 407313-001
RF cable 408485-001
RF input adapter cable 407940-001
TV tuner remote control 408479-001
USB infrared receiver 408843-001
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lllustrated Parts Catalog

Table 3-6

Miscellaneous (Not lllustrated)

Spare Part Information (Continued)

Spare Part
Description Number
Screw Kit (includes the following screws; refer to 409068-001

Appendix A, “Screw Listing,” for more information on

specifications and usage)

H Phillips PM3.0x6.0 Screw

B Phillips PM3.0x3.0 screw

B Phillips PM2.5x11.0 screw

W Phillips PM2.5x7.0 Screw

W Phillips PM2.5%x6.0 screw

B Black Phillips PM2.5x5.0 screw

B Silver Phillips PM2.5x5.0 Screw
B Phillips PM2.5x3.0 screw

B Phillips PM2.0x6.0 Screw

H Phillips PM2.0x4.0 Screw

Bl Phillips PM2.0x3.0 Screw

B Slotted M1.5x9.0 screw

USB travel mouse 309674-001
USB digital drive 364727-001
Wired headset with volume control 371693-001
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lllustrated Parts Catalog

Table 3-6

Miscellaneous (Not lllustrated)

Spare Part Information (Continued)

Spare Part
Description Number
Power supply, 65 watt 403810-001
Power cords
For use in:
Australia 403811-011
Canada, French Canada, and the United States 403811-001
Denmark 403811-081
France, Germany, and Spain 403811-B31
India 403811-D61
Israel 403811-BB1
Italy 403811-061
Japan 403811-291
Korea 403811-AD1
The People’s Republic of China 403811-AA1
Switzerland 403811-111
Taiwan 403811-AB1
The United Kingdom 403811-031
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3.8 Sequential Part Number Listing

Table 3-7

Sequential Part Number Listing

Spare Part

Number Description

309674-001 USB travel mouse

364727-001  USB digital drive

371693-001  Wired headset with volume control
397922-001 Bluetooth module (includes Bluetooth module cable)
403573-001 SD Memory Card 256-MB

403810-001 Power supply, 65 watt

403811-001 Power cord for use in the United States
403811-011 Power cord for use in Australia
403811-031 Power cord for use in the United Kingdom
403811-061 Power cord for use in Italy

403811-081 Power cord for use in Denmark
403811-111 Power cord for use in Sweden and Finland
403811-291 Power cord for use in Japan

403811-AA1  Power cord for use in the People’s Republic of China
403811-AB1  Power cord for use in Taiwan

403811-AD1  Power cord for use in Korea

403811-B31 Power cord for use internationally
403811-BB1  Power cord for use in Israel

403811-D61  Power cord for use in India

403827-001 Heat sink (includes thermal paste)
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lllustrated Parts Catalog

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part

Number Description

407107-001 802.11b/g WLAN Mini Card module for use in the following
MOW1 category countries:
Antigua and Dominican Malaysia

Barbuda Republic Mexico

Argentina Guam New Zealand
Australia Guatemala Paraguay
Bahamas Hong Kong Saudi Arabia
Barbados Panama Taiwan
Brunei India The United States
Canada Indonesia Vietnam
Chile

407107-002  802.11a/b/g WLAN Mini Card module for use in the following
ROW category countries:
China Pakistan South Korea
Ecuador Peru Uruguay
Haiti Qatar Venezuela
Honduras

407316-001 SD Memory Card 512-MB

407576-001 802.11a/b/g WLAN Mini Card module for use in the following

MOWT1 category countries:

Antigua and Dominican Malaysia

Barbuda Republic Mexico
Argentina Guam New Zealand
Australia Guatemala Paraguay
Bahamas Hong Kong Saudi Arabia
Barbados Panama Taiwan
Brunei India The United States
Canada Indonesia Vietnam
Chile
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lllustrated Parts Catalog

Table 3-7

Sequential Part Number Listing (Continued)

Spare Part

Number Description

407576-002  802.11a/b/g WLAN Mini Card module for use in the following
MOW?2 category countries:
Aruba Georgia Liechtenstein
Austria Germany Lithuania
Azerbaijan Greece Luxembourg
Bahrain Hungary Malta
Belgium Iceland Monaco
Bermuda Ireland The Netherlands
Bulgaria Italy Norway
Cayman Islands Latvia Oman
Columbia Lebanon Slovenia
Croatia The Philippines South Africa
Cyprus Poland Spain
Czech Republic Portugal Sri Lanka
Denmark Romania Sweden
Egypt Russia Switzerland
El Salvador Serbia and Turkey
Estonia Montenegro The United
Finland Singapore Kingdom
France Slovakia Uzbekistan

407576-003  802.11a/b/g WLAN Mini Card module for use in the following
ROW category countries:
China Pakistan South Korea
Ecuador Peru Uruguay
Haiti Qatar Venezuela
Honduras

407759-001 945GM system board

407761-001 Intel Pentium M 1.83-GHz processor (include thermal paste)

407762-001 Intel Pentium M 2.0-GHz processor (include thermal paste)
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Table 3-7
Sequential Part Number Listing (Continued)

Spare Part
Number Description

407775-001 Cable Kit

407779-001 Plastics Kit

407781-001 Rubber Pad Kit

407785-001 Speakers

407793-001 Display Plastics Kit

407795-001 Display Screw Kit

407797-001 Display Hinge Kit

407798-001 Display Panel Kit for use with antiglare displays

407799-001 Display Panel Kit for use with BrightView displays

407800-001 Display inverter board

407800-001 Display inverter board

407809-001 ExpressCard assembly

407812-001 TouchPad bracket

407815-001 Base enclosure

407816-001 RTC battery (includes 2-sided tape)

407821-001 Bracket Kit

407823-001 Top cover for use with defeatured computer models
(includes TouchPad)

407824-001  Top cover for use with full-featured computer models
(includes TouchPad)

407827-001 Switch cover

407829-001 PC Card assembly

407834-001 6-cell, 4.0-Amp hour battery pack
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Table 3-7

Sequential Part Number Listing (Continued)

Spare Part

Number Description

407835-001 12-cell, 8.8-Amp hour battery pack

407840-001 15.4-inch, WXGA display assembly with antiglare for use with
UMA system boards (includes display cable, wireless antenna
boards, and antenna cables)

407842-001 15.4-inch, WXGA display assembly with BrightView for use
with discrete system boards (includes display cable, wireless
antenna boards, and antenna cables)

407856-001 Keyboard for use in The United States

407856-031 Keyboard for use in The United Kingdom

407856-051 Keyboard for use in France

407856-061 Keyboard for use in ltaly

407856-071 Keyboard for use in Spain

407856-081 Keyboard for use in Denmark

407856-091 Keyboard for use in Norway

407856-121 Keyboard for use in French Canada

407856-161 Keyboard for use in Latin America

407856-171 Keyboard for use in Saudi Arabia

407856-281 Keyboard for use in Thailand

407856-AD1  Keyboard for use in Korea

407856-B31  Keyboard for use internationally

407856-B71  Keyboard for use in Sweden and Finland

407861-001 Display release button assembly

407863-001 Expansion port 2 bracket

407939-001 Composite S-Video and audio cable
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Table 3-7

Sequential Part Number Listing (Continued)

Spare Part
Number Description
407940-001 RF input adapter cable
407941-001  Analog TV tuner
408479-001 TV tuner remote control
408485-001  RF cable
408843-001 USB infrared receiver
409058-001  1-DIMM, PC2-5300 256 MB memory module
409059-001  1-DIMM, PC2-5300 512 MB memory module
409060-001 1-DIMM, PC2-5300 1024 MB memory module
409061-001 5400-RPM, 40-GB hard drive (includes frame and connector)
409062-001 5400-RPM, 60-GB hard drive (includes frame and connector)
409063-001 5400-RPM, 80-GB hard drive (includes frame and connector)
409064-001 5400-RPM, 100-GB hard drive (includes frame and connector)
409068-001  Screw Kit
409071-001 LED board for use with full-featured models (includes
LED board cable)
409073-001 Fan assembly (includes thermal paste)
409078-001 USB/audio board for use with full-featured models (includes
USB/audio board cable)
409250-004  802.11b/g WLAN Mini Card module
Israel Thailand Ukraine
Jordan United Arab
Kuwait Emirates
410118-001 Wireless antenna transceivers and cables (includes tape)
412175-001  DVB-T TV tuner
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Table 3-7

Sequential Part Number Listing (Continued)

Spare Part

Number Description

412176-001 DVB-T TV tuner antenna

417699-001 DVD/CD-RW Double-Layer Combo Drive with LightScribe
and Hitachi LG Data Storage

430198-001 945GM system board for use with full-featured computer
models

430199-001 945GML system board for use with defeatured computer
models

430200-001 Intel Core Solo 1.83-GHz processor

430201-001 Intel Core Solo 1.66-GHz processor

430202-001 Intel Celeron M 1.60-GHz processor

430208-001 DVD/CD-RW Double-Layer Combo Drive

430209-001  DVD-ROM drive

430210-001 DVD/CD-RW Super Multi Double-Layer Combo Drive

430211-001 DVD/CD-RW Double-Layer Combo Drive

430212-001 DVD/CD-RW Super Multi Double-Layer Combo Drive with
LightScribe

430216-001 Display Label Kit

430329-001 5400 rpm 120-GB hard drive

430530-001 15.4-inch, WXGA display assembly with BrightView for use
with UMA system boards

430531-001 15.4-inch, WXGA display assembly with antiglare for use with
UMA system boards

430533-001 Display Cable Kit

430847-001 Intel Core Duo T2600 2.16-GHz processor

430848-001 Intel Core Duo T2300E 1.66-GHz processor
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Table 3-7
Sequential Part Number Listing (Continued)

Spare Part
Number Description

430849-001 Intel Celeron 410 1.46-GHz processor

430850-001 Intel Core Duo T2050 1.60-GHz processor

430851-001 Intel Core Duo 2250 1.73-GHz processor

430852-001 Intel Core Solo T1350 1.86-GHz processor
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4

Removal and Replacement
Preliminaries

This chapter provides essential information for proper and
safe removal and replacement service.

4.1 Tools Required

You will need the following tools to complete the removal and
replacement procedures:

Magnetic screwdriver

Phillips PO screwdriver

Flat-bladed screwdriver

Tool kit—includes connector removal tool, loopback plugs,
and case utility tool

Maintenance and Service Guide 4-1



Removal and Replacement Preliminaries

4.2 Service Considerations

The following sections include some of the considerations
that you should keep in mind during disassembly and assembly
procedures.

% As you remove each subassembly from the computer, place
the subassembly (and all accompanying screws) away from
the work area to prevent damage.

Plastic Parts

Using excessive force during disassembly and reassembly can
damage plastic parts. Use care when handling the plastic parts.
Apply pressure only at the points designated in the maintenance
instructions.

Cables and Connectors

fi CAUTION: When servicing the computer, ensure that cables are
placed in their proper locations during the reassembly process.
Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage.
Apply only the tension required to unseat or seat the cables
during removal and insertion. Handle cables by the connector
whenever possible. In all cases, avoid bending, twisting,

or tearing cables. Ensure that cables are routed in such a way
that they cannot be caught or snagged by parts being removed
or replaced. Handle flex cables with extreme care; these cables
tear easily.
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4.3 Preventing Damage to
Removable Drives

Removable drives are fragile components that must be handled
with care. To prevent damage to the computer, damage to a
removable drive, or loss of information, observe the following
precautions:

Before removing or inserting a hard drive, shut down the
computer. If you are unsure whether the computer is off or

in hibernation, turn the computer on, and then shut it down
through the operating system.

Before removing a diskette drive or optical drive, ensure that
a diskette or disc is not in the drive and ensure that the optical
drive tray is closed.

Before handling a drive, ensure that you are discharged of
static electricity. While handling a drive, avoid touching the
connector.

Handle drives on surfaces covered with at least one inch of
shock-proof foam.

Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette
drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic
fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack
mailer or other suitable form of protective packaging and label
the package “FRAGILE: Handle With Care.”
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4.4 Preventing Electrostatic Damage

Many electronic components are sensitive to electrostatic
discharge (ESD). Circuitry design and structure determine the
degree of sensitivity. Networks built into many integrated circuits
provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt

silicon junctions.

A sudden discharge of static electricity from a finger or other
conductor can destroy static-sensitive devices or microcircuitry.
Often the spark is neither felt nor heard, but damage occurs.

An electronic device exposed to electrostatic discharge may not
be affected at all and can work perfectly throughout a normal
cycle. Or the device may function normally for a while, then
degrade in the internal layers, reducing its life expectancy.
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4.5 Packaging and Transporting
Precautions

Use the following grounding precautions when packaging and
transporting equipment:

To avoid hand contact, transport products in static-safe
containers, such as tubes, bags, or boxes.

Protect all electrostatic-sensitive parts and assemblies with
conductive or approved containers or packaging.

Keep electrostatic-sensitive parts in their containers until
the parts arrive at static-free workstations.

Place items on a grounded surface before removing items
from their containers.

Always be properly grounded when touching a sensitive
component or assembly.

Store reusable electrostatic-sensitive parts from assemblies
in protective packaging or nonconductive foam.

Use transporters and conveyors made of antistatic belts and
roller bushings. Ensure that mechanized equipment used for
moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not
possible, use an ionizer to dissipate electric charges.
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4.6 Workstation Precautions

Use the following grounding precautions at workstations:

Cover the workstation with approved static-shielding material
(refer to Table 4-2, “Static-Shielding Materials”).

Use a wrist strap connected to a properly grounded work
surface and use properly grounded tools and equipment.

Use conductive field service tools such as cutters,
screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use
fixtures made only of static-safe materials.

Keep the work area free of nonconductive materials such
as ordinary plastic assembly aids and Styrofoam.

Handle electrostatic-sensitive components, parts, and
assemblies by the case or PCM laminate. Handle these
items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing
connectors or test equipment.
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4.7 Grounding Equipment and
Methods

Grounding equipment must include either a wrist strap or a
foot strap at a grounded workstation.

When seated, wear a wrist strap connected to a grounded
system. Wrist straps are flexible straps with a minimum of
one megohm +10% resistance in the ground cords. To provide
proper ground, wear a strap snugly against the skin at all times.
On grounded mats with banana-plug connectors, use alligator
clips to connect a wrist strap.

When standing, use foot straps and a grounded floor mat.
Foot straps (heel, toe, or boot straps) can be used at standing
workstations and are compatible with most types of shoes
or boots. On conductive floors or dissipative floor mats, use
foot straps on both feet with a minimum of one megohm
resistance between the operator and ground. To be effective,
the conductive strips must be worn in contact with the skin.

Other grounding equipment recommended for use in preventing
electrostatic damage includes

Antistatic tape.

Antistatic smocks, aprons, and sleeve protectors.
Conductive bins and other assembly or soldering aids.
Nonconductive foam.

Conductive tabletop workstations with ground cords of
one megohm resistance.

Static-dissipative tables or floor mats with hard ties to
the ground.

Field service kits.

Static awareness labels.

Material-handling packages.

Nonconductive plastic bags, tubes, or boxes.

Metal tote boxes.

Electrostatic voltage levels and protective materials.
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Table 4-1 shows how humidity affects the electrostatic voltage
levels generated by different activities.

Table 4-1

Typical Electrostatic Voltage Levels

Relative Humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500 V
Walking across vinyl floor 12,000 V 5,000 V 3,000 V
Motions of bench worker 6,000 V 800V 400V

Removing DIPS from plastic tube 2,000V 700V 400V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V
Removing bubble pack from PCB 26,500 V 20,000V 7,000V
Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

%\ A product can be degraded by as little as 700 V.

Table 4-2 lists the shielding protection provided by antistatic
bags and floor mats.

Table 4-2
Static-Shielding Materials
Material Use Voltage Protection Level
Antistatic plastic Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000 V
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5

Removal and Replacement
Procedures

This chapter provides removal and replacement procedures.

There are as many as 93 screws, in 12 different sizes, that may
have to be removed, replaced, or loosened when servicing the
computer. Make special note of each screw size and location
during removal and replacement.

Refer to Appendix A, “Screw Listing,” for detailed information
on screw sizes, locations, and usage.
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5.1 Serial Number

Report the computer serial number to HP when requesting
information or ordering spare parts. The serial number is
located on the bottom of the computer.

Serial Number Location
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5.2 Disassembly Sequence Chart

Use the chart below to determine the section number to be
referenced when removing computer components.

Disassembly Sequence Chart

Section Description # of Screws Removed
5.3 Preparing the Computer for
Disassembly
Battery pack 0
5.4 Hard Drive 2 loosened to remove
the hard drive cover
4 to disassemble the
hard drive
5.5 Computer Feet 0
5.6 Memory Module 1 loosened to remove the
memory/Mini Card module
compartment cover,
5.7 Mini Card Module 0
A To prevent an unresponsive system and the display of a
warning message, install only a Mini Card device
authorized for use in your computer by the governmental
agency that regulates wireless devices in your country. If
you install a device and then receive a warning message,
remove the device to restore computer functionality. Then
contact Customer Care.
5.8 RTC Battery 0
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Disassembly Sequence Chart (Continued)

Section Description # of Screws Removed

5.9 Optical Drive 1 to remove the optical drive,
2 to remove the optical drive
bracket

5.10 Switch Cover 2

5.11 Keyboard 4

5.12 Display Assembly 6 to remove the display
assembly

6 to remove the display bezel
2 to remove the display hinge
base covers

4 to remove the display panel
2 to remove the display
release hook

4 to remove each display
hinge

1 to remove each wireless
antenna transceiver

5.13 Base Enclosure 18

5.14 Bluetooth Module 2

5.15 System Board 4

5.16 Display Release Button 6

Assembly

5.17 LED Board 2

5.18 Fan/Heat Sink Assembly 10

5.19 Processor 1 loosened
5.20 PC Card Assembly 2

5.21 ExpressCard Assembly 2
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5.3 Preparing the Computer for
Disassembly

Before you begin any removal or installation procedures:

1. Shut down the computer. If you are unsure whether the
computer is off or in hibernation, turn the computer on,
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power cord.

Battery Pack Spare Part Number Information

12-cell, 8.8-Amp hour 407835-001
6-cell, 4.0-Amp hour 407834-001
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4. Remove the battery pack by following these steps:
a. Turn the computer upside down with the front toward you.

b. Slide the battery pack release latch @ to the left. (The
battery pack disengages from the computer.)

c. Lift the front edge of the battery pack @ and swing it back
to remove it.

()

Removing the Battery Pack

Reverse the above procedure to install the battery pack.
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5.4 Hard Drive

Hard Drive Spare Part Number Information

5400 rpm, 120-GB 430329-001
5400 rpm, 100-GB 409064-001
5400 rpm, 80-GB 409063-001
5400 rpm, 60-GB 409062-001
5400 rpm, 40-GB 409061-001

1. Prepare the computer for disassembly (refer to Section 5.3).

2. Loosen the two Phillips PM2.5x5.0 captive screws @ that
secure the hard drive cover to the computer.

3. Lift the rear edge of the hard drive cover @, and then swing
it up and forward and remove it.

The hard drive cover is included in the Plastics Kit, spare part
number 415691-001.

Removing the Hard Drive Cover
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4. Slide the hard drive @ to the right, and then lift the hard
drive @ from the hard drive bay.

Removing the Hard Drive
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5. Remove the four Phillips PM3.0x4.0 hard drive frame
screws @ that secure the hard drive frame to the hard drive.

6. Slide the hard drive @ away from the hard drive to remove it.

[2)
o

Removing the Hard Drive Frame

Reverse the above procedure to reassemble and install the
hard drive.
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5.5 Computer Feet

The computer feet are adhesive-backed rubber pads. The feet are
included in the Plastics Kit, spare part number 415691-001.

% There are two additional computer feet that are installed on the
12-cell battery pack. These additional feet are not depicted in
the following image.

-
|
|
|
|
|

Replacing the Computer Feet
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5.6 Memory Module

Memory Module Spare Part Number Information

Memory modules (1 DIMM)

PC2-5300

1024 MB 409060-001
512 MB 409059-001
256 MB 409058-001

1. Prepare the computer for disassembly (refer to Section 5.3).
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2. Loosen the Phillips PM2.5x5.0 captive screw @ that secures
the memory/Mini Card module compartment cover to the
computer.

3. Lift the right side of the cover @ and swing it up and to the
left and remove it.

% The memory/Mini Card module compartment cover is included
in the Plastics Kit, spare part number 415691-001.

Removing the Memory/Mini Card Module Compartment Cover
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4. Spread the retaining tabs @ on each side of the memory
module socket to release the memory module. (The edge
of the module opposite the socket rises away from
the computer.)

5. Remove the memory module by pulling the module away
from the socket at an angle @.

% Memory modules are designed with notches @ to prevent
incorrect installation into the memory module socket.

Removing the Memory Module

Reverse the above procedure to install a memory module.
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5.7 Mini Card Module

Mini Card Module

Spare Part Number Information

802.11a/b/g Mini Card WLAN module for use in the following 407576-001
MOW 1 category countries:
Antigua and Canada Panama Paraguay
Barbuda Chile India Saudi Arabia
Argentina Dominican Indonesia Taiwan
Australia Republic Malaysia The United
Bahamas Guam Mexico States
Barbados Guatemala New Zealand Vietnam
Brunei Hong Kong
802.11a/b/g Mini Card WLAN module for use in the following 407576-002
MOW 2 countries:
Aruba Estonia Poland Norway
Austria Finland Portugal Oman
Azerbaijan France Romania Slovenia
Bahrain Georgia Russia South Africa
Belgium Germany Serbia and Montenegro  Spain
Bermuda Greece Singapore Sri Lanka
Bulgaria Hungary Slovakia Sweden
Cayman Islands Iceland Liechtenstein Switzerland
Columbia Ireland Lithuania Turkey
Croatia Italy Luxembourg The United
Cyprus Latvia Malta Kingdom
Czech Republic Lebanon Monaco Uzbekistan
Denmark The The Netherlands
Egypt Philippines
El Salvador
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Mini Card Module

Spare Part Number Information (Continued)

802.11a/b/g Mini Card WLAN module for use in the following 407576-003

ROW category countries:

China Honduras Qatar Uruguay

Ecuador Pakistan South Korea Venezuela

Haiti Peru

802.11b/g WLAN module for use in the MOW1 countries listed 407107-001

below:

Antigua & Barbuda Canada Panama Paraguay

Argentina Chile India Saudi Arabia

Australia Dominican Indonesia Taiwan

Bahamas Republic Malaysia The United

Barbados Guam Mexico States

Brunei Guatemala New Zealand Vietnam
Hong Kong

802.11b/g WLAN module for use in the ROW countries listed ~ 407107-002

below:

China Honduras Qatar Uruguay

Ecuador Pakistan South Korea Venezuela

Haiti Peru

802.11b/g Mini Card WLAN module for use in the following 409250-004

countries:

Jordan Kuwait United Arab Emirates Ukraine

Israel Thailand

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the memory/Mini Card module compartment cover

(Section 5.6).
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% Before disconnecting the antenna cables, make note of which
cable is attached to which antenna clip on the Mini Card
communications card.

3. Disconnect the auxiliary and main @ antenna cables from
the Mini Card communications module.

4. Slide the retaining bar @ forward. (The edge of the module
opposite the socket rises away from the computer.)

5. Remove the Mini Card communications module by pulling
the module away from the socket at an angle ©.

% Mini Card communications modules are designed with
notches @ to prevent incorrect installation into the Mini Card
module socket.

Removing a Mini Card Communications Module

Reverse the above procedure to install a Mini Card
communications module.
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5.8 RTC Battery

RTC Battery Spare Part Number Information

RTC battery (includes tape) 407816-001

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the memory/Mini Card module compartment cover
(Section 5.6).

3. Remove the Mini Card communications module
(Section 5.7).

4. Remove the RTC battery from the socket on the
system board.

Removing the RTC Battery

Reverse the above procedure to install an RTC battery.
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5.9 Optical Drive

Optical Drive Spare Part Number Information

DVD+RW and CD-RW Double-Layer Combo Drive with 417699-001
LightScribe and Hitachi LG Data Storage

DVD+RW and CD-RW Super Multi Double-Layer Combo 430210-001
Drive with LightScribe

DVD+RW and CD-RW Super Multi Double-Layer Combo 430212-001
Drive

DVD+RW and CD-RW Double-Layer Combo Drive 430211-001
DVD/CD-RW Combo Drive 430208-001
DVD-ROM drive 430209-001

1. Prepare the computer for disassembly (Section 5.3).

2. Position the computer with the left side toward you.
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3. Remove the Phillips PM2.5%5.0 screw @ that secures the
optical drive to the computer.

4. Insert a thin tool into the notch @ on the back of the optical
drive and push to disconnect the optical drive from the system
board.

5. Remove the optical drive ©.

Removing the Optical Drive
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If it is necessary to replace the optical drive bracket, perform
the following steps:

6. Position the optical drive with the connector toward you.

7. Remove the two Phillips PM2.0x4.0 screws @ that secure
the optical drive bracket to the optical drive.

8. Remove the optical drive bracket @.

Removing the Optical Drive Bracket

Reverse the above procedure to install an optical drive.
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5.10 Switch Cover

Switch Cover Spare Part Number Information

Switch cover 407827-001

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the two Phillips PM2.5x5.0 screws that secure the
switch cover to the computer.

Removing the Switch Cover Screws
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3. Turn the computer display-side up with the front toward you.
4. Open the computer as far as possible.

5. Insert a flat-bladed tool into the switch cover notches behind
the f1, 5, f11, and insert keys @ and lift up until the switch
cover @ disengages from the computer.

6. Remove the switch cover.

Removing the Switch Cover

Reverse the above procedure to install the switch cover.
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5.11 Keyboard

Keyboard Spare Part Number Information

Denmark 407856-081 Norway 407856-091
France 407856-051 Saudi Arabia 407856-171
French Canada 407856-121 Spain 407856-071
International 407856-B31 Sweden/Finland 407587-B71
ltaly 407856-061 Thailand 407856-281
Korea 407856-AD1  The United Kingdom 407856-031
Latin America 407856-161 The United States 407856-001

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the switch cover (Section 5.10).
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3. Remove the four Phillips PM2.5%5.0 screws @ that secure
the keyboard to the computer.

4. Lift the rear edge of the keyboard @ to release it from the
top cover.

Releasing the Keyboard
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5. Swing the keyboard @ forward until it rests on the palm rest.

6. Release the zero insertion force (ZIF) connector to which
the keyboard cable @ is attached and disconnect the
keyboard cable ©.

7. Remove the keyboard assembly.

Removing the Keyboard

Reverse the above procedure to install the keyboard.
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5.12 Display Assembly

Display Assembly Spare Part Number Information

All display assemblies include a display cable, wireless antenna
transceivers, and antenna cables.

For use with UMA system boards

15.4-inch, WXGA with BrightView 430530-001
15.4-inch, WXGA with antiglare 430531-001
For use with discrete system boards

15.4-inch, WXGA with BrightView 407842-001
15.4-inch, WXGA with antiglare 407840-001

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the memory/Mini Card module compartment cover
(Section 5.6).
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% Before disconnecting the antenna cables, make note of which
cable is attached to which antenna clip on the Mini Card
communications card.

3. Disconnect the auxiliary and main wireless antenna cables @
from the Mini Card module.

4. Remove the two Phillips PM2.5x13.0 screws @ that secure
the display assembly to the computer.

Disconnecting the Wireless Antenna Cables and Removing the
Display Screws
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5. Remove the switch cover (Section 5.10).
6. Remove the keyboard (Section 5.11).
7. Disconnect the display cable @ from the system board.

8. Remove the wireless antenna cables from the clips @ in the
top cover.

Disconnecting the Display and Wireless Antenna Cables
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CAUTION: Support the display assembly when removing the following
screws. Failure to support the display assembly can result in damage to
the display assembly and other computer components.

9. Remove the four Phillips PM2.5%9.0 screws @ that secure
the display assembly to the computer.

10. Lift the display assembly straight up and remove it @.

Removing the Display Assembly
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Display Assembly Subcomponents

Spare Part Number Information

Display Plastics Kit, includes 407793-001
W Display bezel

B Display enclosure

W Display hinge base covers

W Display hinge covers

Display Hinge Kit, includes 407797-001
W Display hinges
B Display release hook

Display inverter board 407800-001
Display Panel Kit (includes display panel cable)

B 15.4-inch, WXGA with BrightView 407799-001
W 15.4-inch, WXGA antiglare 407798-001
Wireless Antenna Kit (includes cable and transceivers) 410118-001
Display Label Kit (not illustrated) 430216-001
Display Cable Kit (not illustrated) 430533-001
Display Screw Kit, includes: 407795-001

B Phillips PM2.5x7.0 screws
B Phillips PM2.5x5.0 screws
B Rubber screw covers
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11. Remove the six rubber screw covers @ and @ and the
six Phillips PM2.5x7.0 screws @ that secure the display
bezel to the display assembly.

% The rubber screw covers are available in the Display Screw Kit,
spare part number 407795-001.

The four rubber screw covers @ on top edge of the display bezel
are a different size and shape than the two rubber screw covers @
on the bottom edge of the display bezel.

! /efw BN

Removing the Display Bezel Screws
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% The display bezel and display enclosure are available in the
Display Plastics Kit, spare part number 407793-001.

12. Flex the inside edges of the left and right sides @ and the
top and bottom sides @ of the display bezel until the bezel
disengages from the display enclosure.

13. Remove the display bezel ©.

Removing the Display Bezel
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14. Disconnect the display panel cable @ and display backlight
cable @ from the display inverter board.

o

Disconnecting the Display Panel Cables
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% The display hinge base covers are available in the Display
Plastics Kit, spare part number 407793-001.

15. If is necessary to replace the display hinge base covers,
remove the two Phillips PM2.5x5.0 screws @ that secure
the covers to the display enclosure.

16. Remove the display hinge base covers @.

Removing the Display Hinge Base Covers
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Display Assembly Subcomponents
Spare Part Number Information

Display Panel Kit (includes display panel cable)
B 15.4-inch, WXGA with BrightView 407799-001
M 15.4-inch, WXGA antiglare 407798-001

Display inverter board 407800-001

17. Remove the four Phillips PM2.5%5.0 screws @ that secure
the display panel and inverter board to the display enclosure.

18. Remove the display panel @ and inverter board ©.

Removing the Display Panel and Inverter Board
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% The display hinge covers are available in the Display Plastics
Kit, spare part number 407793-001.

19. If it is necessary to replace either of the display hinge covers,
detach the display hinge cover clips @ from the
display hinge.

20. Swing the display hinge cover @ back until it clears the
display hinge.

21. Slide the hinge cover @ off of the display hinge.

Removing the Display Hinge Covers
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% The display release hook is available in the Display Hinge Kit,
spare part number 407797-001.

22. If it is necessary to replace the display release hook, remove
the two PM2.5x5.0 screws @ that secure the hook to the
display enclosure.

23. Remove the display release hook @.

Removing the Display Release Hook
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% The display hinges are available in the Display Hinge Kit,
spare part number 407797-001.

24. If it is necessary to replace the display hinges, remove the
four Phillips PM2.0x4.0 screws @ that secure each hinge
to the display panel.

25. Remove the display hinges @.

Removing the Display Hinges
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The wireless antenna transceivers and cables are available in
the Wireless Antenna Kit, spare part number 410118-001.

26. If it is necessary to replace the wireless antenna transceivers
and cables, remove the Phillips PM2.5%5.0 screws @ that
secure the wireless antenna transceivers to the display
enclosure.

27. Release the retention tabs @ built in to the display enclosure
lining that secure the wireless antenna cables to the display
enclosure.

28. Detach the wireless antenna transceivers @ from the display
enclosure.

29. Remove the wireless antenna transceivers and cables @.

Removing the Wireless Antenna Transceivers and Cables

Reverse the above procedure to reassemble and install the
display assembly.
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Removal and Replacement Procedures

5.13 Base Enclosure

Base Enclosure

Spare Part Number Information

Base enclosure 407815-001

1. Prepare the computer for disassembly (Section 5.3) and then
remove the following components:

a. Hard drive (Section 5.4)

Memory/Mini Card module compartment cover
(Section 5.6)

Optical drive (Section 5.9)

S

Switch cover (Section 5.10)
Keyboard (Section 5.11)
Display assembly (Section 5.12)

- 0o Ao o

5-40 Maintenance and Service Guide



Removal and Replacement Procedures

2. Release the ZIF connector to which the TouchPad cable @ is
connected and disconnect the TouchPad cable @ from the
system board.

% The TouchPad cable is included in the Cable Kit, spare part
number 407775-001.

3. Remove the two Phillips PM2.5x13.0 screws @ that secure
the base enclosure to the computer.

Disconnecting the TouchPad Cable and Removing the Base
Enclosure Screws, Part 1
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Removal and Replacement Procedures

4. Turn the computer upside down with the front toward you.

5. Remove the eleven Phillips PM2.5x13.0 screws that secure
the base enclosure to the computer.

Removing the Base Enclosure Screws, Part 2
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Removal and Replacement Procedures

6. Remove the two Phillips PM2.5%5.0 screws @ in the hard
drive bay and and the three Phillips PM2.5x5.0 screws @ in
the battery bay that secure the base enclosure to the computer.

Removing the Base Enclosure Screws, Part 3
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Removal and Replacement Procedures

7. Lift up the front edge of the base enclosure @ until it
disengages from the top cover.

8. Lift the base enclosure @ straight up and remove it.

Removing the Base Enclosure

Reverse the above procedure to install the base enclosure.
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Removal and Replacement Procedures

5.14 Bluetooth Module

Bluetooth Module Spare Part Number Information

Bluetooth module (includes Bluetooth module cable) 397922-001

1. Prepare the computer for disassembly (Section 5.3),
and then remove the following components:

a.
b.

@ e e o

Hard drive (Section 5.4)

Memory/Mini Card module compartment cover
(Section 5.6)

Optical drive (Section 5.9)
Switch cover (Section 5.10)
Keyboard (Section 5.11)
Display assembly (Section 5.12)

Base enclosure (Section 5.13)
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Removal and Replacement Procedures

2. Remove the two Phillips PM1.5x%3.0 screws @ that secure
the Bluetooth module to the top cover.

3. Slide the Bluetooth module @ out of the clip in the top cover.

4. Disconnect the Bluetooth module cable @ from the
Bluetooth module.

5. Disconnect the Bluetooth module cable @ from the system
board.

The Bluetooth module cable is included with the Bluetooth
module and is also available in the Cable Kit, spare part
number 407774-001.

Removing the Bluetooth Module

Reverse the above procedure to install the Bluetooth module.
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Removal and Replacement Procedures

5.15 System Board

System Board Spare Part Number Information

945GM for use with full-featured computer models 430198-001
940GML for use with defeatured computer models 430199-001

% When replacing the system board, ensure that the following
components are removed from the defective system board and
installed on the replacement system board:

Memory modules (Section 5.6)

Mini Card communications module (Section 5.7)
RTC battery (Section 5.8)

Power connector cable (Section 5.15)

Heat sink (Section 5.18)

Processor (Section 5.19)

Fan/heat sink assembly (Section 5.18)

PC Card assembly (Section 5.20)

2.

. Prepare the computer for disassembly (Section 5.3),

and then remove the following components:
a. Hard drive (Section 5.4)

b. Memory/Mini Card module compartment cover
(Section 5.6)

Optical drive (Section 5.9)
Switch cover (Section 5.10)
Keyboard (Section 5.11)
Display assembly (Section 5.12)

@ ™o A o

Base enclosure (Section 5.13)

=

urn the top cover right-side up with the front toward you.
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Removal and Replacement Procedures

3. Release the ZIF connector @ to which the LED board cable is
connected and disconnect the LED board cable @ from the
system board.

Disconnecting the LED Board Cable
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Removal and Replacement Procedures

4. Turn the top cover upside down with the front toward you.

5. Disconnect the power connector cable @ from the system
board.

6. Remove the power connector @ from the clip in the base
enclosure and remove the cable from the routing channel ©
in the top cover.

Removing the Power Connector Cable
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Removal and Replacement Procedures

7. Remove the modem connector @ from the clip in the top
cover and remove the modem connector cable @ from the
routing channel in the top cover.

8. Disconnect the USB/audio board cable ® from the
USB/audio board.

Removing the Modem Connector Cable
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Removal and Replacement Procedures

9. Remove the four PM2.5x5.0 screws @ that secure the
system board and USB/audio board to the top cover.

10. Remove the USB/audio board @ from the top cover.

11. If it is necessary to replace the USB/audio board cable,
disconnect the cable @ from the USB/audio board.

% The USB/audio board is available using spare part numbers
407804-001 (for use with full-featured models) and
407805-001 (for use with defeatured models). The USB/audio
board cable is included with the USB/audio board and is also
available in the Cable Kit, spare part number 407774-001.

Removing the USB/Audio Board
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Removal and Replacement Procedures

12. Use the optical drive connector @ to lift the left side of the
system board @ until it clears the top cover.

13. Slide the system board @ to the left at an angle and remove it.

Removing the System Board
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Removal and Replacement Procedures

14. Position the system board with the ExpressCard and PC Card
assemblies facing up and the battery connector toward you.

15. Disconnect the following cables from the system board:
@ USB/audio board cable
® Modem cable
® Speaker cable

The USB/audio board cable is included with the USB/audio
board and is also available in the Cable Kit, spare part number
407774-001.

The modem connector cable is available in the Cable Kit, spare
part number 407774-001.

Disconnecting the USB/Audio Board, Speaker, and
Modem Cables
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Removal and Replacement Procedures

16. Set the USB/audio board cable and modem connector cable
aside.

17. Lift the system board and separate the speakers from the
system board.

% The speakers are available using spare part number
407785-001.

Removing the Speakers

Reverse the above procedure to install the system board.
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Removal and Replacement Procedures

5.16 Display Release Button
Assembly

1. Prepare the computer for disassembly (Section 5.3) and then
remove the following components:

a.
b.

- 0o a o

Hard drive (Section 5.4)

Memory/Mini Card module compartment cover
(Section 5.6)

Optical drive (Section 5.9)
Switch cover (Section 5.10)
Keyboard (Section 5.11)
Display assembly (Section 5.12)

Base enclosure (Section 5.13)
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Removal and Replacement Procedures

2. Release the ZIF connector @ on the TouchPad board to which
the TouchPad cable is connected and disconnect the
TouchPad cable @ from the TouchPad board.

% The TouchPad cable is included in the Cable Kit, spare part
number 407774-001.

3. Remove the TouchPad cable ©.

Removing the TouchPad Cable
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Removal and Replacement Procedures

4. Remove the four silver Phillips PM2.5x4.0 screws @ and the
two Phillips PM2.5x5.0 screws @ that secure the TouchPad
bracket to the top cover.

5. Remove the TouchPad bracket ©.

Removing the TouchPad Bracket
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Removal and Replacement Procedures

6. Remove the display release button swing arm @ from the
top cover.

7. Push and hold the display release button @.

8. Remove the display release button @ and springs @ from
the top cover.

Removing the Display Release Button Assembly

Reverse the above procedure to install the display release button
assembly.
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Removal and Replacement Procedures

5.17 LED Board

LED Board Spare Part Number Information

LED board (includes LED board cable) 409071-001

1. Prepare the computer for disassembly (Section 5.3),
and then remove the following components:

a.
b.

e o

5o oo

Hard drive (Section 5.4)

Memory/Mini Card module compartment cover
(Section 5.6)

Optical drive (Section 5.9)
Switch cover (Section 5.10)
Keyboard (Section 5.11)
Display assembly (Section 5.12)
Base enclosure (Section 5.13)
System board (Section 5.15)
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Removal and Replacement Procedures

2. Remove the two Phillips PM2.5%5.0 screws @ that secure
the LED board to the top cover.

3. Remove the LED board and cable @.

Removing the LED Board

Reverse the above procedure to install the LED board.
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Removal and Replacement Procedures

5.18 Fan/Heat Sink Assembly

Fan/Heat Sink Assembly Spare Part Number Information

Fan assembly (includes thermal paste) 409073-001
Heat sink assembly (includes thermal paste) 403827-001

1. Prepare the computer for disassembly (Section 5.3),
and then remove the following components:

a.
b.

e o

5o oo

Hard drive (Section 5.4)

Memory/Mini Card module compartment cover
(Section 5.6)

Optical drive (Section 5.9)
Switch cover (Section 5.10)
Keyboard (Section 5.11)
Display assembly (Section 5.12)
Base enclosure (Section 5.13)
System board (Section 5.15)
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Removal and Replacement Procedures

2. Turn the system board upside down with the expansion
port 2 toward you.

3. Remove the Phillips PM2.0x4.0 screw that secures the
fan/heat sink assembly to the system board.

Removing the Fan/Heat Sink Assembly Screws, Part 1
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Removal and Replacement Procedures

4. Turn the system board upside down with the expansion port 2
toward you.

5. Disconnect the fan cable @ from the system board.

6. Remove the four Phillips PM2.5x7.0 screws @ that secure
the heat sink to the system board.

Removing the Fan/Heat Sink Assembly Screws, Part 2

Maintenance and Service Guide 5-63



Removal and Replacement Procedures

7. Remove the following screws:

@ One silver Phillips PM2.5x4.0 screw that secures the
expansion port 2 bracket and fan/heat sink assembly to
the system board

® Two Phillips PM3.0x6.0 screws on each side of the
external monitor port that secure the fan/heat sink
assembly to the system board

® Two slotted M1.5%9.0 screws on each side of the
expansion port 2 that secure the expansion port bracket
and fan/heat sink assembly to the system board

Removing the Fan/Heat Sink Assembly Screws, Part 3
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Removal and Replacement Procedures

8. Slide the expansion port 2 bracket @ away from the system
board.

9. Remove the fan/heat sink assembly @.

% Due to the adhesive quality of the thermal paste located
between the fan/heat sink assembly and processor, it may be
necessary to move the fan/heat sink assembly from side to side
to detach it from the processor.

Removing the Fan/Heat Sink Assembly
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Removal and Replacement Procedures

% The thermal paste should be thoroughly cleaned from the
surfaces of the processor @ and fan/heat sink assembly @ each
time the fan/heat sink assembly is removed. Thermal paste
should be reapplied to both surfaces before the fan/heat sink
assembly is reinstalled. Thermal paste is included with all
fan/heat sink assembly and processor spare part kits.

Replacing the Thermal Paste

Reverse the above procedure to install the fan/heat sink assembly.
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Removal and Replacement Procedures

5.19 Processor

Processor Spare Part Number Information

%\ All processor spare part kits include thermal paste.

Intel Pentium M 2.0-GHz 407762-001
Intel Pentium M 1.83-GHz 407761-001
Intel Celeron 1.60-GHz 430202-001
Intel Celeron 410 1.46-GHz 430849-001
Intel Core Duo T2600 2.16-GHz 430847-001
Intel Core Duo T2250 1.73-GHz 430851-001
Intel Core Duo T2300E 1.66-GHz 430848-001
Intel Core Duo T2050 1.60-GHz 430850-001
Intel Core Solo T1350 1.86-GHz 430852-001
Intel Core Solo 1.83-GHz 430200-001
Intel Core Solo 1.66-Ghz 430201-001

1. Prepare the computer for disassembly (Section 5.3),
and then remove the following components:

a.
b.

& 0

= oo

— o

Hard drive (Section 5.4)

Memory/Mini Card module compartment cover
(Section 5.6)

Optical drive (Section 5.9)
Switch cover (Section 5.10)
Keyboard (Section 5.11)
Display assembly (Section 5.12)
Base enclosure (Section 5.13)
System board (Section 5.15)
Heat sink (Section 5.18)
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Removal and Replacement Procedures

2. Use a flat-bladed screwdriver to turn the processor locking
screw @ one-half turn counterclockwise until you hear a
click.

3. Lift the processor straight up and remove it @.

% The gold triangle @ on the processor should be aligned with
the triangle icon @ in the front right corner when you install the

processor.

Removing the Processor

Reverse the above procedure to install the processor.
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Removal and Replacement Procedures

5.20 PC Card Assembly

PC Card Assembly Spare Part Number Information

PC Card assembly 407829-001

1. Prepare the computer for disassembly (Section 5.3),
and then remove the following components:

a.
b.

=0 ™o a8 o

Hard drive (Section 5.4)

Memory/Mini Card module compartment cover
(Section 5.6)

Optical drive (Section 5.9)
Switch cover (Section 5.10)
Keyboard (Section 5.11)
Display assembly (Section 5.12)
Base enclosure (Section 5.13)

System board (Section 5.15)
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Removal and Replacement Procedures

2. Turn the system board upside down with the expansion port 2
toward you.

3. Remove the two PM2.0x4.0 screws that secure the PC Card
assembly to the system board.

Removing the PC Card Assembly Screws
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Removal and Replacement Procedures

4. Turn the system board top-side up with the expansion port 2
toward you.

5. Disengage the hooks @ on the PC Card assembly from the
slots on the PC Card connector @ and remove the PC Card
assembly ® from the system board.

Removing the PC Card Assembly

Reverse the above procedures to install the PC Card assembly.
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Removal and Replacement Procedures

5.21 ExpressCard Assembly

ExpressCard Assembly Spare Part Number Information

ExpressCard assembly 407809-001

1. Prepare the computer for disassembly (Section 5.3),
and then remove the following components:

a.
b.

=0 ™o a8 o

Hard drive (Section 5.4)

Memory/Mini Card module compartment cover
(Section 5.6)

Optical drive (Section 5.9)
Switch cover (Section 5.10)
Keyboard (Section 5.11)
Display assembly (Section 5.12)
Base enclosure (Section 5.13)

System board (Section 5.15)
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Removal and Replacement Procedures

2. Turn the system board upside down with the expansion port 2
toward you.

3. Remove the two PM2.0x4.0 screws that secure the
ExpressCard assembly to the system board.

Removing the ExpressCard Assembly Screws
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Removal and Replacement Procedures

4. Turn the system board top-side up with the expansion port 2
toward you.

5. Remove the ExpressCard Assembly from the system board.

Removing the ExpressCard Assembly

Reverse the above procedures to install the ExpressCard
assembly.

5-74 Maintenance and Service Guide



6

Specifications

This chapter provides physical and performance specifications.

Table 6-1
Computer
Dimensions Metric U.S.
Height
Front 3.50 cm 1.38in.
Rear 4.50 cm 1.77 in.
Width 35.79 cm 14.09 in.
Depth 26.39 cm 10.39 in.
Weight
With 17.0-inch display, optical 2.99 kg 6.60 Ibs
drive and 8-cell battery pack
Input Power
Operating voltage 18.5V dcto 19.0 Vdc
Operating current 35Ao0r4.74 Aord49A
Temperature
Operating 10°C to 35°C 50°F to 95°F
Nonoperating -20°C to 60°C -4°F to 140°F
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Specifications

Table 6-1

Computer (Continued)

Relative humidity (noncondensing)

Operating 10% to 90% 10% to 90%
Nonoperating 5% to 95% 5% to 95%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia) -15mt0 3,048 m -50 ft to 10,000 ft
Nonoperating (14.7 to 4.4 psia) -15mto 12,192 m  -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine
Nonoperating 200 g, 2 ms, half-sine
Random Vibration
Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz,
0.25 oct/min sweep rate
Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz,

0.5 oct/min sweep rate

Applicable product safety standards specify thermal limits for plastic
surfaces. The computer operates well within this range of temperatures.
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Specifications

Table 6-2
15.4-inch, WXGA, Display

Dimensions

Height
Width
Diagonal

20.7 cm 8.151in
33.1 cm 13.03in
39.1cm 15.39in

Number of colors

Up to 16.8 million

Contrast ratio

200:1

Brightness

180 nits typical

Pixel resolution

Pitch 0.259 x 0.259 mm
Format 1280 x 800
Configuration RGB vertical stripe

Backlight Edge lit

Character display 80 x 25

Total power consumption 4 W

Viewing angle

+/-65° horizontal, +50° vertical typical
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Table 6-3
Hard Drives
120-GB* 100-GB* 80-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm

Weight 102 g 102 g 99g¢
Interface type ATA-5 ATA-5 ATA-5
Transfer rate

Synchronous (maximum) 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ~ ATA security ~ ATA security
Seek times (typical read, including setting)

Single track 3ms 3ms 3 ms

Average 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms
Logical blockst 234,428,430 195,364,233 156,301,488
Disc rotational speed 4200 rpm 4200 rpm 5400 rpm

Operating temperature

5°C to 55°C (41°F to 131°F)

Certain restrictions and exclusions apply. Consult Customer Care

for details.

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual

accessible capacity is less.
TActual drive specifications may differ slightly.
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Specifications

Table 6-3

Hard Drives (Continued)

80-GB* 60-GB* 40-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm

Weight 99g¢ 99g¢ 99g
Interface type ATA-5 ATA-5 ATA-5
Transfer rate

Synchronous (maximum) 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security  ATA security  ATA security
Seek times (typical read, including setting)

Single track 3ms 3ms 3ms

Average 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms
Logical blockst 156,301,488 117,210,240 78,140,160
Disc rotational speed 4200 rpm 4200 rpm 4200 rpm

Operating temperature

5°C to 55°C (41°F to 131°F)

Certain restrictions and exclusions apply. Consult Customer Care

for details.

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual

accessible capacity is less.
tActual drive specifications may differ slightly.
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Specifications

Table 6-4
DVD/CD-RW Combo Drive

Applicable disc Read: Write:
DVD-R, DVD-RW, DVD-ROM (DVD-5, CD-R and CD-RW
DVD-9, DVD-10, DVD-18), CD-ROM
(Mode 1 and 2) CD Digital Audio,
CD-XA ready (Mode 2, Form 1 and
2), CD-I ready (Mode 2, Form 1
and 2), CD-R, CD-RW, Photo CD
(single and multisession), and
CD-Bridge

Center hole 1.5 cm (0.59 in)
diameter

Disc diameter
Standard disc 12 cm (4.72 in)

Mini disc 8.cm (3.151n)
Disc thickness 1.2 mm (0.047 in)
Track pitch 0.74 pym
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Specifications

Table 6-4
DVD/CD-RW Combo Drive (Continued)

Access time CD media DVD media

Random <110 ms <130 ms

Full stroke <210 ms <225 ms
Audio output Line-out, 0.7 V rms
level
Cache buffer 2 MB

Data transfer rate

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)
CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)
CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X) 10,800 KB/s (1352 KB/s at 1X DVD rate)
Multiword DMA  16.6 MB/s
mode 2

Startup time < 15 seconds

Stop time < 6 seconds
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Table 6-5

DVD:RW and CD-RW Double-Layer Combo Drive

Applicable disc

Read:

DVD-R, DVD-RW, DVD-ROM (DVD-5,
DvD-9, DVD-10, DVD-18), CD-ROM
(Mode 1 and 2), CD Digital Audio,
CD-XA ready (Mode 2, Form 1 and
2), CD-I ready (Mode 2, Form 1

and 2), CD-R, CD-RW, Photo CD
(single and multisession), CD-Bridge

Write:
CD-R and CD-RW

DVD-R and
DVD-RW

Center hole
diameter

1.5 cm (0.59 in)

Disc diameter
Standard disc

12cm (4.72 in)

Mini disc 8.cm (3.151n)
Disc thickness 1.2 mm (0.047 in)
Track pitch 0.74 pm
6-8 Maintenance and Service Guide



Specifications

Table 6-5

DVD:RW and CD-RW Double-Layer Combo Drive (Continued)
Access time CD DVD

Random <175 ms <230 ms

Full stroke <285 ms <335 ms
Audio output Audio-out, 0.7 Vrms
level
Cache buffer 2 MB

Data transfer rate

CD-R (16X) 2,400 KB/s (150 KB/s at 1X CD rate)
CD-RW (8X) 1,200 KB/s (150 KB/s at 1X CD rate)
CD-ROM (24X) 3,600 KB/s (150 KB/s at 1X CD rate)
DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)
DVD-R (4X) 5,400 KB/s (1,352 KB/s at 1X DVD rate)
DVD-RW (2X) 2,700 KB/s (1,352 KB/s at 1X DVD rate)
Multiword DMA  16.6 MB/s

mode 2
Startup time < 15 seconds
Stop time < 6 seconds
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Table 6-6

System Interrupts

Hardware IRQ

System Function

IRQO

System timer

IRQ1 Standard 101-/102-Key or Microsoft Natural Keyboard
IRQ2 Cascaded
IRQ3 USB2 Enhanced Host Controller—24CD
IRQ4 COM1
IRQ5* Conexant AC—Link Audio
Data Fax Modem with SmartCP
IRQ6 Diskette drive
IRQ7* Parallel port
IRQ8 System CMOS/real-time clock
IRQ9* Microsoft ACPI-compliant system
IRQ10* Realtek RTL8139 Family PCI fast Ethernet Controller
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Specifications

Table 6-6
System Interrupts (Continued)
IRQ11 TI OHCI 1394 host controller
TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad
IRQ13 Numeric data processor
IRQ14 Primary IDE channel
IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9,
IRQ10, or none.

%\ PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or
IRQ15. Either the infrared or the serial port may assert IRQ3 or IRQ4.
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Specifications

Table 6-7
System I/O Addresses

/0 Address (hex)

System Function (shipping configuration)

000 - 00F DMA controller no. 1

010-01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers
025 - 03F Unused

02E - 02F 87334 “Super 1/O” configuration for CPU
040 - O5F Counter/timer registers

044 - O5F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - O7F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0AO - 0A1 Interrupt controller no. 2
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Table 6-7
System I/O Addresses (Continued)

/0 Address (hex) System Function (shipping configuration)
0A2 - 0BF Unused

0CO - ODF DMA controller no. 2

OEO - OEF Unused

OFO - OF1 Coprocessor busy clear/reset
OF2 - OFF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller
178 - 1EF Unused

1FO - 1F7 Primary fixed disk controller
1F8 - 200 Unused

201 Joystick (decoded in ESS1688)
202 - 21F Unused

220 - 22F Entertainment audio

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2ES8 - 2EF Reserved serial port
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Table 6-7

System I/O Addresses (Continued)

/0O Address (hex)

System Function (shipping configuration)

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370 - 377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)
3CO0 - 3DF VGA

3EO0 - 3E1 PC Card controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3FO0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)
CFC - CFF PCI configuration data register (PCIDIVO-1)
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Table 6-8
System Memory Map

Size Memory Address

System Function

640 KB 00000000-0009FFFF

Base memory

128 KB 000A0000-000BFFFF

Video memory

48 KB 000C0000-000CBFFF Video BIOS
160 KB 000C8000-000E7FFF Unused
64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF

Extended memory

58 MB 01000000-047FFFFF

Super extended memory

58 MB 04800000-07FFFFFF

Unused

2 MB 08000000-080FFFFF Video memory (direct access)
4GB 08200000-FFFEFFFF Unused
64 KB FFFF0000-FFFFFFFF System BIOS
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Table 6-9
System DMA

Hardware DMA

System Function

DMAO Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMAS Not applicable

DMA4 Direct memory access controller
DMA5* Available for PC Card

DMA6 Not assigned

DMA7 Not assigned

*PC Card controller can use DMA 1, 2, or 5.
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Screw Listing

This appendix provides specification and reference information
for the screws and screw locks used in the computer. All screws
listed in this appendix are available in the Computer Screw Kit,
spare part number 409068-001, and the Display Screw Kit, spare
part number 407795-001.
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Screw listing

Table A-1
Phillips PM2.5x5.0 Captive Screw

= Head
mn7]|||||||||||||||||||| Color Qty Length Thread Width
Black 3 5.0 mm 2.5 mm 5.0 mm

Where used:

@ Two Mini Card screws that secure the hard drive cover to the computer
(screws are captured on the cover by C clips; documented in Section 5.4)

® One screw that secures the memory/Mini Card module compartment cover

to the computer (screw is captured on the cover by a C clip; documented in
Section 5.6)

Phillips PM2.5x5.0 Captive Screw Locations
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Screw listing

Table A-2
Phillips PM3.0x4.0 Screw

§ Head
mminnnnnn Color Qty. Length Thread  Width
Black 4 4.0 mm 3.0 mm 5.0 mm

Where used:

4 screws that secure the hard drive frame to the hard drive (documented in
Section 5.4)

Phillips PM3.0x4.0 Screw Locations
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Screw listing

Table A-3
Phillips PM2.5x5.0 Screw

= Head
mI'ITI|||||||||||||||||||| Color Qty Length Thread Width

Black 30 5.0 mm 2.5 mm 5.0 mm

Where used:

One screw that secures the optical drive to the computer (documented in
Section 5.9)

»

Phillips PM2.5x5.0 Screw location
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Screw listing

Table A-3
Phillips PM2.5x5.0 Screw (Continued)

= Head
mI'ITI|||||||||||||||||||| Color Qty Length Thread Width

Black 30 5.0 mm 2.5 mm 5.0 mm

Where used:

2 screws that secure the switch cover to the computer (documented in
Section 5.10)

Phillips PM2.5x5.0 Screw locations
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Screw listing

Table A-3
Phillips PM2.5x5.0 Screw (Continued)

= Head
mnTNIIIIIIIIlIIIIIIIIlI Color Qty Length Thread Width

Black 30 5.0 mm 2.5 mm 5.0 mm

Where used:

4 screws that secure the keyboard to the computer (documented in
Section 5.11)

Phillips PM2.5x5.0 Screw Locations
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Screw listing

Table A-3
Phillips PM2.5x5.0 Screw (Continued)

= Head
mnTNIIIIIIIIlIIIIIIIIlI Color Qty Length Thread Width

Black 30 5.0 mm 2.5 mm 5.0 mm

Where used:

2 screws that secure the display hinge base covers to the display enclosure
(documented in Section 5.12)

Phillips PM2.5x5.0 Screw locations
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Screw listing

Table A-3
Phillips PM2.5x5.0 Screw (Continued)

= Head
mnTNIIIIIIIIlIIIIIIIIlI Color Qty Length Thread Width

Black 30 5.0 mm 2.5 mm 5.0 mm

Where used:
4 screws that secure the display panel and inverter board to the display
enclosure (documented in Section 5.12)

i

.
[
I
I
[
[
[

.. _._..

Phillips PM2.5x5.0 Screw locations
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Screw listing

Table A-3
Phillips PM2.5x5.0 Screw (Continued)

= Head
mI'ITI|||||||||||||||||||| Color Qty Length Thread Width

Black 30 5.0 mm 2.5 mm 5.0 mm

Where used:

2 screws that secure the display release hook to the display enclosure
(documented in Section 5.12)

Phillips PM2.5x5.0 Screw locations
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Screw listing

Table A-3
Phillips PM2.5x5.0 Screw (Continued)

= Head
mI'ITI|||||||||||||||||||| Color Qty Length Thread Width

Black 30 5.0 mm 2.5 mm 5.0 mm

Where used:

2 screws that secure the wireless antenna transceivers to the display enclosure
(documented in Section 5.12)

Phillips PM2.5x5.0 Screw locations

A-10 Maintenance and Service Guide



Screw listing

Table A-3
Phillips PM2.5x5.0 Screw (Continued)

= Head
mI'ITI|||||||||||||||||||| Color Qty Length Thread Width

Black 30 5.0 mm 2.5 mm 5.0 mm

Where used:

5 screws that secure the base enclosure to the computer (documented in
Section 5.13)

Phillips PM2.5x5.0 Screw Locations
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Screw listing

Table A-3
Phillips PM2.5x5.0 Screw (Continued)

= Head
mnTNIIIIIIIIlIIIIIIIIlI Color Qty Length Thread Width

Black 30 5.0 mm 2.5 mm 5.0 mm

Where used:

4 screws that secure the system board to the top cover (documented in
Section 5.15)

Phillips PM2.5x5.0 Screw locations
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Screw listing

Table A-3
Phillips PM2.5x5.0 Screw (Continued)

= Head
mnT||||||||||||||||||||| Color Qty Length Thread Width

Black 30 5.0 mm 2.5 mm 5.0 mm

Where used:

2 screws that secure the TouchPad bracket to the top cover (documented in
Section 5.16)

Phillips PM2.5x5.0 Screw Locations
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Screw listing

Table A-3
Phillips PM2.5x5.0 Screw (Continued)

= Head
mnTNIIIIIIIIlIIIIIIIIlI Color Qty Length Thread Width

Black 30 5.0 mm 2.5 mm 5.0 mm

Where used:

2 screws that secure the LED board to the top cover (documented in
Section 5.17)

Phillips PM2.5x5.0 Screw locations
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Screw listing

Table A-4
Phillips PM2.0x3.0 Screw

@ Im Head

T Color Qty. Length Thread Width

S

m

Silver 2 3.0 mm 2.0 mm 5.0 mm

Where used:

2 screws that secure the optical drive bracket to the optical drive (documented in
Section 5.9)

Phillips PM2.0x3.0 Screw locations
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Screw listing

Table A-5
Phillips PM2.0x4.0 Screw

E@ (e Head
mnT‘|||||||||||||||||||| Color Qty Length Thread Width
Black 13 4.0 mm 2.0 mm 4.0 mm
Where used:

8 screws that secure the display hinges to the display panel (documented in
Section 5.12)

Phillips PM2.0x4.0 Screw locations
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Screw listing

Table A-5
Phillips PM2.0x4.0 Screw (Continued)

=0 m Head
mmiuH Color Qty Length Thread Width

Black 13 4.0 mm 2.0 mm 4.0 mm

Where used:

One screw that secures the fan/heat sink assembly to the system board
(documented in Section 5.18)

Phillips PM2.0x4.0 Screw Location
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Screw listing

Table A-5
Phillips PM2.0x4.0 Screw (Continued)

=0 [m Head
mﬁllllllllllllllllllll Color Qty Length Thread Width

Black 13 4.0 mm 2.0 mm 4.0 mm

Where used:

2 screws that secure the PC Card assembly to the system board (documented
in Section 5.20)

Phillips PM2.0x4.0 Screw Locations
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Screw listing

Table A-5
Phillips PM2.0x4.0 Screw (Continued)

=0 m Head
mmiuH Color Qty Length Thread Width

Black 13 4.0 mm 2.0 mm 4.0 mm

Where used:

2 screws that secure the ExpressCard assembly to the system board
(documented in Section 5.21)

Phillips PM2.0x4.0 Screw Locations
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Screw listing

Table A-6
Phillips PM2.5x13.0 Screw

=(F) | Head
mminmnnnnnn Color Qty. Length Thread  Width

Black 15 13.0mm 2.5mm 5.0 mm

Where used:

2 screws that secure the display assembly to the computer (documented in
Section 5.12)

Phillips PM2.5x13.0 Screw Locations
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Screw listing

Table A-6
Phillips PM2.5x13.0 Screw (Continued)

=(F) | Head
mmnHnnnnnn Color Qty. Length Thread  Width

Black 15 13.0mm 2.5mm 5.0 mm

Where used:

2 screws that secure the base enclosure to the computer (documented in
Section 5.13)

Phillips PM2.5x13.0 Screw Locations
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Screw listing

Table A-6
Phillips PM2.5x13.0 Screw (Continued)

=) |mmmmm Head
mminmnnnnnn Color Qty. Length Thread  Width

Black 15 13.0mm 2.5mm 5.0 mm

Where used:

11 screws that secure the base enclosure to the computer (documented in
Section 5.13)

Phillips PM2.5x13.0 Screw Locations
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Screw listing

Table A-7
Phillips PM2.5x9.0 Screw

=) | Head
mminmnnnnnn Color Qty. Length Thread  Width
Black 4 9.0 mm 2.5 mm 5.0 mm

Where used:

4 screws that secure the display assembly to the computer (documented in
Section 5.12)

Phillips PM2.5x9.0 Screw Locations
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Screw listing

Table A-8
Phillips PM2.5x7.0 Screw

;@ﬂmmm Head
mminHnnnnn Color Qty. Length Thread  Width

Silver 10 7.0 mm 2.5 mm 6.0 mm

Where used:

6 screws that secure the display bezel to the display enclosure (documented in
Section 5.12)

Phillips PM2.5x7.0 Screw locations
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Screw listing

Table A-8
Phillips PM2.5x7.0 Screw (Continued)

Head
mminmnnnnnn Color Qty. Length Thread  Width

Silver 10 7.0 mm 2.5 mm 6.0 mm

Where used:

4 screws that secure the heat sink to the system board (documented in
Section 5.18)

Phillips PM2.5x7.0 Screw Locations
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Screw listing

Table A-9
Phillips PM1.5x3.0 Screw

O m Head
mn7]|||||||||||||||||||| Color Qty Length Thread Width
Silver 2 3.0 mm 1.5 mm 3.0 mm

Where used:

2 screws that secure the Bluetooth module to the top cover (documented in
Section 5.14)

Phillips PM1.5x3.0 Screw Locations
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Screw listing

Table A-10
Silver Phillips PM2.5x4.0 Screw

@ [m Head

T Color Qty. Length Thread Width

S

m

Silver 5 4.0 mm 2.5 mm 5.0 mm

Where used:

4 screws that secure the display bezel to the display enclosure (documented in
Section 5.16)

Silver Phillips PM2.5x4.0 Screw Locations
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Screw listing

Table A-10
Silver Phillips PM2.5x4.0 Screw (Continued)

= Head
mnT||||||||||||||||||||| Color Qty Length Thread Width
Silver 5 4.0 mm 2.5 mm 5.0 mm

Where used:

One screw that secures the expansion port 2 bracket and fan/heat sink
assembly to the system board (documented in Section 5.18)

Silver Phillips PM2.5x4.0 Screw Location
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Screw listing

Table A-11
Slotted SM1.5x9.0 Screw

S Hoad
mnT||||||||||||||||||||| Color Qty Length Thread Width
Silver 2 9.0 mm 1.5 mm 4.0 mm

Where used:

2 screws that secure the fan/heat sink assembly to the system board
(documented in Section 5.18)

Slotted SM1.5x9.0 Screw Locations
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Screw listing

Table A-12
Phillips PM3.0x6.0 Screw

=@ Head
mminnnnnn Color Qty. Length Thread  Width
Black 2 6.0 mm 3.0 mm 4.0 mm

Where used:

2 screws that secure the fan/heat sink assembly to the system board
(documented in Section 5.18)

Phillips PM3.0x6.0 Screw Locations
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Software Update
and Recovery

Updating Software

SN

Updated versions of the software provided with your computer
may be available on the HP Web site.

Most software and BIOS updates on the HP Web site are
packaged in compressed files called SoftPags.

Some download packages contain a file named Readme.txt,
which contains information regarding installing and
troubleshooting the file.

To update the software:

1. Identify your computer model, product category, and series or
family. Prepare for a system BIOS update by identifying the
BIOS version currently installed on the computer.

If your computer is connected to a network, consult the
network administrator before installing any software updates,
especially system BIOS updates.

The computer system BIOS is stored on the system ROM. The
BIOS initializes the operating system, determines how the
computer will interact with the hardware devices, and provides
for data transfer among hardware devices, including the time
and date.

2. Access the updates by visiting the HP Web site at
http://www.hp.com.

3. Install the updates.
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Software Update and Recovery

Updating the BIOS

To determine whether available BIOS updates contain later BIOS
versions than those currently installed on the computer, you need
to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System
BIOS) can be displayed by pressing fn+esc (if you are already in
Microsoft® Windows®) or by opening the Setup Utility.

To use the Setup Utility for displaying BIOS information:

1. Open the Setup Utility by turning on or restarting the
computer, and then pressing f10 while the “Press <F10> to
enter Setup” message is displayed in the lower-left corner
of the screen.

2. If the Setup Utility does not open with the system
information displayed, use the arrow keys to select the Main
menu.

When the Main menu is selected, BIOS and other system
information is displayed.

3. To exit the Setup Ultility, use the arrow keys to select Exit >
Exit Discarding Changes, and then press enter.

CAUTION: To prevent damage to the computer or an unsuccessful
installation, download and install a BIOS update only when the computer
is connected fo reliable external power using the AC adapter. Do not
download or install a BIOS update while the computer is running on
battery power, docked in an optional docking device, or connected to an
optional power source. During the download and installation, follow these
instructions:

B Do not disconnect power from the computer by unplugging the power
cord from the AC outlet.

B Do not shut down the computer or initiate standby or hibernation.

B Do not insert, remove, connect, or disconnect any device, cable, or
cord.
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Software Update and Recovery

To download a BIOS update:

1. Access the page on the HP Web site that provides software
for your computer:

Select Start > Help and Support, and then select the
software and drivers update.

2. Follow the instructions on the screen to identify your
computer and access the BIOS update you want to download.

3. At the download area:

a. Identify the BIOS update that is later than the BIOS
version currently installed on your computer. Make a note
of the date, name, or other identifier. You may need this
information to locate the update later, after it has been
downloaded to your hard drive.

b. Follow the instructions on the screen to download your
selection to the hard drive.

Make a note of the path to the location on your hard drive
where the BIOS update will be downloaded. You will need
to access this path when you are ready to install the update.

% If you connect your computer to a network, consult the
network administrator before installing any software updates,
especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that
are displayed on the screen after the download is complete. If no
instructions are displayed, follow these steps:

1. Open Windows Explorer by selecting Start > All
Programs > Accessories > Windows Explorer.

2. In the left pane of the Windows Explorer window:

a. Click My Computer and then your hard drive
designation. The hard drive designation is typically
Local Disk (C:).

b. Using the hard drive path you recorded earlier, open the
folder on your hard drive that contains the update.
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Software Update and Recovery

3. Double-click the file that has an .exe extension (for example,
filename.exe).

The BIOS installation begins.

4. Complete the installation by following the instructions on
the screen.

% After a message on the screen reports a successful installation,
you can delete the downloaded file from your hard drive.

Updating Software Programs and Drivers

To download and install software other than a BIOS update:

1. Access the page on the HP Web site that provides software
for your computer:

Select Start > Help and Support, and then select the
software and drivers update.

2. Follow the instructions on the screen to find the software
you want to update.

3. At the download area, select the software you want to
download and follow the instructions on the screen.

% Make a note of the path to the location on your hard drive
where the software will be downloaded. You will need to
access this path when you are ready to install the software.

4. When the download is complete, open Windows Explorer by
selecting Start > All Programs > Accessories > Windows
Explorer.

5. In the left pane of the Windows Explorer window:

a. Click My Computer and then your hard drive
designation. The hard drive designation is typically
Local Disk (C:).

b. Using the hard drive path you recorded earlier, open the
folder on your hard drive that contains the update.
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Software Update and Recovery

6. Double-click the file that has an .exe extension (for example,

filename.exe).

The installation begins.

7. Complete the installation by following the instructions on

the screen.

% After a message on the screen reports a successful installation,
you can delete the download package from your hard drive.

Recovering System Information

Tools provided by the operating system and PC Recovery
software are designed to help you with the following tasks for
safeguarding your information and restoring it in case of a system
failure:

Back up your information regularly to protect your important
system files.

Make a set of recovery discs (PC Recovery software feature).
Recovery discs are used to start up (boot) your computer and
restore the operating system and software programs to factory
settings in case of system failure or instability.

Create system restore points (operating system feature).
System restore points allow you to reverse undesirable
changes to your computer by restoring the computer to an
earlier state.

Recover a program or driver (PC Recovery software feature).
This feature helps you reinstall a program or driver without
performing a full system recovery.

Perform a full system recovery (PC Recovery software
feature). With PC Recovery, you can recover your full factory
image if you experience system failure or instability. PC
Recovery works from a dedicated recovery partition on the
hard drive or from recovery discs you create.
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Software Update and Recovery

Backing Up Your Information

When to Back Up

On a regularly scheduled basis.

% Set reminders to back up your information periodically.

Before the computer is repaired or restored.

Before you add or modify hardware or software.

Backup Suggestions

Create system restore points using Windows XP Professional
System Restore feature.

Store personal files in the My Documents folder and back up
these folders periodically.

Back up templates stored in their associated programs.

Save customized settings in a window, toolbar, or menu bar
by taking a screen shot of your settings.

The screen shot can be a time saver if you have to reset your
preferences.

To copy the screen and paste it into a Word document:
a. Display the screen.
b. Copy the screen:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

c. To paste the copied images into a document, open Word,
and then select Edit > Paste.
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Software Update and Recovery

Using System Restore Points

When you back up your system, you are creating a system restore
point. A system restore point allows you to save and name a
snapshot of your hard drive at a specific point in time. You can
then recover back to that point if you want to reverse subsequent
changes made to your system.

% Recovering to an earlier restore point does not affect data files
saved or e-mails created since the last restore point.

You also can create additional restore points to provide increased
protection for your system files and settings.

When to Create Restore Points

B Before you add or extensively modify software or hardware.

B Periodically, whenever the system is performing optimally.

% If you revert to a restore point and then change your mind, you
can reverse the restoration.

Create a System Restore Point

1. Select Start > Help and Support, and then click System
Restore.

The System Restore window opens.
2. Click Create a restore point, and then click Next.

3. Follow the on-screen instructions.
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Software Update and Recovery

Restore to a Previous Date and Time

To revert to a restore point (created at a previous date and time),
when the computer was functioning optimally:

1. Select Start > Help and Support, and then click System
Restore.

The System Restore window opens.

2. Click Restore my computer to an earlier time, and then
click Next.

3. Follow the on-screen instructions.

Creating Recovery Discs

PC Recovery Disc Creator creates a set of recovery CDs or DVDs
for the computer. Use recovery discs to restore the operating
system and software programs to factory settings, in case of
system failure or instability.

% Handle these discs carefully and keep them in a safe place. The
software allows the creation of only one set of recovery discs.

Note the following guidelines before creating recovery discs:

B You will need high quality CD-R, DVD-R, or DVD+R media
(purchased separately).

% DVD+RW/R and double-layer DVD+RW are not compatible
with the PC Recovery Disc Creator software.

B The computer must be connected to AC power during this
process.

B Only one set of recovery discs can be created per computer.
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Software Update and Recovery

B Number each disc before inserting it into the computer
optical drive.

B If necessary, you can exit the program before you have
finished creating the recovery discs. The next time you open
PC Recovery Disc Creator, you will be prompted to continue
the disc creation process.

To create a set of recovery discs:

1. Select Start > All Programs > System Recovery >
PC Recovery Disc Creator.

The PC Recovery Disc Creator tool opens.
2. Click Next.

% If you are operating the computer on battery power, you will be
prompted to connect to AC power before you can go to the next
step.

3. Select the type of disc you want to use and click Next.

% The software examines the image and displays the number of
blank discs needed to create your recovery discs.

4. Insert the first disc and follow the on-screen instructions to
complete the creation of the recovery discs.
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Software Update and Recovery

Reinstalling Software Programs and Drivers

If a program or driver preinstalled at the factory is accidentally
erased or is damaged, the Application and Driver Recovery tool
allows you to reinstall it.

% Software not provided with this computer must be reinstalled
from the disc provided by the manufacturer or downloaded
from the manufacturer's Web site.

% Before reinstalling the program, be sure it is fully uninstalled.

The Application and Driver Recovery tool replaces corrupted
system files and reinstalls deleted system files within the
program.

B In most cases, if the program you are reinstalling is still on
your computer, the reinstallation process does not affect your
personal settings.

B In all cases, if a program has been deleted from your
computer, the reinstallation process reinstalls the program or
utility to the factory image but cannot restore your personal
settings.

Reinstalling Preinstalled Programs and
Drivers

1. Remove the program or driver:

In some cases, drivers are not listed in the Add or Remove
Programs list. If the driver is not listed, it does not need to be
removed.

a. Select Start > Control Panel > Add or Remove
Programs.

b. Click the program or driver you want to remove, and then
click Change/Remove.
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Software Update and Recovery

2. Select Start > All Programs > System Recovery >
Application and Driver Recovery.

The Application and Driver Recovery tool opens.

3. Select Application Installation or Driver Installation, and
then click Next.

4. Follow the on-screen instructions to complete the program
or driver recovery.

5. Restart the computer if prompted.

Reinstalling Programs from Discs

1. Insert the disc into the optical drive.

2. When the installation wizard opens, follow the installation
instructions on the screen.

3. Restart the computer if prompted.

Performing a Recovery

PC Recovery software allows you to repair or restore the system
if you experience system failure or instability. PC Recovery
works from recovery discs that you create or from a dedicated
recovery partition on the hard drive.

% Microsoft Windows XP has its own built-in repair features,
such as System Restore and driver roll-back capabilities. If you
have not already tried these features, try them before using
PC Recovery.

% PC Recovery only recovers software that was preinstalled at
the factory. Software not provided with this computer must be
reinstalled from the disc provided by the manufacturer or
downloaded from the manufacturer's Web site.
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Software Update and Recovery

Recovering from the Recovery Discs
To restore the system from the recovery discs:
1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart
the computer.

3. Follow the on-screen instructions.

Recovering from the Partition on the
Hard Drive

You can perform a recovery from the partition on the hard drive
from either the Start button or f11.

To restore the system from the partition:
1. Access the PC Recovery tool:

[ To access PC Recovery from the Start button, select
Start > All Programs > System Recovery >
PC Recovery.

[ To access PC Recovery from f11, restart the computer and
press f11 while the “Press <F11> for recovery” message is
displayed on the screen.

The PC Recovery tool opens.
2. Select PC Recovery and click Next.
The computer restarts and the PC Recovery tool opens.
3. Click OK.

4. Follow the on-screen instructions to complete the system
recovery.

If you want to perform a destructive recovery:

% A destructive recovery formats the hard drive and restores the
computer to its factory state. Select this option only as a last
resort.
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Software Update and Recovery

a. Click Advanced Options on the System Recovery screen.

b. Select Destructive Recovery and follow the on-screen
instructions.

Deleting the Recovery Partition on the
Hard Drive

The PC Recovery Advanced Options menu provides the option of
deleting the recovery partition, which will increase space on the
hard drive. Delete the recovery partition only if you have already
created recovery discs.

CAUTION: After you create the recovery discs, you can increase space
on the hard drive by deleting the recovery partition. However, doing this
is not recommended. If you delete this partition, you will lose any
information that is on the partition, including the PC Recovery software.
Thereatfter, you must use the recovery discs fo access PC Recovery
software.

To delete the recovery partition:

1. If you have not already created recovery discs, create
them now.

2. Select Start > All Programs > System Recovery >
PC Recovery.

The PC Recovery tool opens.
3. Select PC Recovery and click Next.

The computer restarts and the PC Recovery tools opens.
4. Click OK.
5. At the System Recovery screen, click Advanced Options.

6. Select Delete Recovery Partition (not recommended) and
follow the on-screen instructions.
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Software Update and Recovery

Updating Reinstalled Software

After you perform a system recovery, connect to the Internet to
update all reinstalled software.

To access update links for the operating system and other
software provided on your computer:

»  Select Start > Help and Support.

To update optional software, follow the instructions provided by
the software manufacturer. Some programs include an update
feature you can access from a Help button or menu within the
program.
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Display Component Recycling

WARNING: The backlight contains mercury. Caution should be
exercised when removing and handling the backlight to avoid
damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this appendix can result in damage to
display components. The only components intended for recycling
purposes are the liquid crystal display (LCD) panel and the backlight.
Careful handling should be exercised when removing these components.

% Materials Disposal

This HP product contains mercury in the display assembly
backlight and may require special handling at end-of-life.

Disposal of mercury may be regulated because of environmental
considerations. For disposal or recycling information, contact
your local authorities or visit the Electronic Industries Alliance
(EIA) at http://www.eiae.org.
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Display Component Recycling

This appendix provides disassembly instructions for the display
assembly. The display assembly must be disassembled to gain
access to the backlight @ and the LCD panel @.

% Disassembly procedures differ from one display assembly to
another. The procedures provided in this appendix are general
disassembly instructions. Specific details, such as screw sizes,
quantities, and locations, and component shapes and sizes, can
vary from one computer model to another.

Refer to Section 5.12, “Display Assembly,” for display assembly
disassembly steps.
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Display Component Recycling

Perform the following steps to disassemble the display assembly:

1. Remove all screw covers @ and screws @ that secure the
display bezel to the display assembly.

—— — —

_o
_e

|
|
|
T
|
|
|
|

— — — — — —— — —
—— — — ——— — —

Removing the Display Bezel Screw Covers and Screws
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Display Component Recycling

2. Lift up and out on the left and right inside edges @ and the
top and bottom inside edges @ of the display bezel until
the bezel disengages from the display assembly.

3. Remove the display bezel ©.

Removing the Display Bezel
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Display Component Recycling

4. Disconnect all LCD panel cables @ from the display inverter
board and remove the inverter board @.

Removing the Display Inverter Board
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Display Component Recycling

5. Remove all screws @ that secure the LCD panel to the
display enclosure.

6. Remove the LCD panel @ from the display enclosure.

!

Removing the LCD Panel
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Display Component Recycling

7. Turn the LCD panel upside down.

8. Remove all screws that secure the LCD panel frame to the
LCD panel.

Removing the LCD Panel Frame Screws
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Display Component Recycling

9. Use a sharp-edged tool to cut the tape @ that secures the
side of the LCD panel to the LCD panel frame.

10. Remove the LCD panel frame @ from the display panel.

Removing the LCD Panel Frame
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Display Component Recycling

11. Remove the screws @ that secure the backlight cover to the
LCD panel.

12. Lift the top edge of the backlight cover @ and swing it
forward.

13. Remove the backlight cover.

-0

6

1
|
I
I
I
I
I
I

Removing the Backlight Cover
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Display Component Recycling

14. Turn the LCD panel right-side up.

15. Remove the backlight cables @ from the clip @ in the
LCD panel.

Releasing the Backlight Cables
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Display Component Recycling

16. Turn the LCD panel upside down.
17. Remove the backlight frame from the LCD panel.

Removing the Backlight Frame
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Display Component Recycling

WARNING: The backlight contains mercury. Caution should be
exercised when removing and handling the backlight to avoid
damaging this component and causing exposure to the mercury.

18. Slide the backlight out of the backlight frame.

t

Removing the Backlight
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Display Component Recycling

19. Disconnect the display cable @ from the LCD panel.

20. Remove the screws @ that secure the LCD panel to the LCD
rear panel.

21. Release the LCD panel © from the LCD rear panel.

22. Release the tape @ that secures the LCD panel to the LCD
rear panel.

Releasing the LCD Panel
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Display Component Recycling

23. Remove the LCD panel.

Removing the LCD Panel

24. Recycle the backlight and LCD panel.
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Connector Pin Assignments

Table D-1
Audio-Out (Headphone)

Pin Signal Pin Signal
1 Audio out, left channel 3 Ground
2 Audio out, right channel
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Connector Pin Assignments

Table D-2
Audio-In (Microphone)

Pin Signal Pin Signal
1 Audio signal in 3 Ground
2 Audio signal in

Table D-3

Universal Serial Bus

12 3 4
 —
Pin Signal Pin Signal
1 +5VDC 3 Data +
2 Data — 4 Ground
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Connector Pin Assignments

Table D-4
S-Video-Out

0886
@eE @

L1

Pin Signal Pin Signal

1 S-VHS color (C) signal 5 TV-CD

2 Composite video signal 6 S-VHS intensity ground
3 S-VHS intensity (Y) signal 7 Composite video ground
4 S-VHS color ground
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Connector Pin Assignments

Table D-5

External Monitor

®OOO0®
®000 M
©O000G

Pin Signal Pin Signal

1 Red analog 9 +5VDC

2 Green analog 10 Ground

3 Blue analog 11 Monitor detect
4 Not connected 12 DDC 2B data

5 Ground 13 Horizontal sync
6 Ground analog 14 Vertical sync

7 Ground analog 15 DDC 2B clock
8 Ground analog
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Connector Pin Assignments

Table D-6
RJ-11 (Modem)

— —
N —
)
P —
N
O —

Pin Signal Pin Signal

1 Unused 4 Unused
2 Tip 5 Unused
3 Ring 6 Unused
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Connector Pin Assignments

Table D-7
RJ-45 (Network)

T
12345678

Pin Signal Pin Signal

1 Transmit + 5 Unused

2 Transmit — 6 Receive —

3 Receive + 7 Unused

4 Unused 8 Unused
D-6 Maintenance and Service Guide



Power Cord Set Requirements

3-Conductor Power Cord Set

The wide range input feature of the computer permits it to operate
from any line voltage from 100 to 120 or 220 to 240 volts AC.

The power cord set included with the computer meets the
requirements for use in the country where the equipment
is purchased.

Power cord sets for use in other countries must meet the
requirements of the country where the computer is used.
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Power Cord Set Requirements

General Requirements

The requirements listed below are applicable to all countries.

The length of the power cord set must be at least 1.5 m
(5.0 ft) and a maximum of 2.0 m (6.5 ft).

All power cord sets must be approved by an acceptable
accredited agency responsible for evaluation in the
country where the power cord set will be used.

The power cord sets must have a minimum current capacity
of 10 amps and a nominal voltage rating of 125 or 250 V AC,
as required by each country’s power system.

The appliance coupler must meet the mechanical
configuration of an EN 60 320/IEC 320 Standard Sheet C13
connector for mating with the appliance inlet on the back of
the computer.

E-2
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Power Cord Set Requirements

Country-Specific Requirements

3-Conductor Power Cord Set Requirements

Country/Region Accredited Agency Applicable Note Number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
Italy IMQ 1
Japan METI 3

RSN

1.

NOTES:

The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 1.0 mm?
conductor size. Power cord set fittings (appliance coupler and wall plug)
must bear the certification mark of the agency responsible for evaluation
in the country where it will be used.

. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG,

3-conductor. The wall plug must be a two-pole grounding type with a
NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

. The appliance coupler, flexible cord, and wall plug must bear a “T” mark

and registration number in accordance with the Japanese Dentori Law. The
flexible cord must be Type VCT or VCTF, 3-conductor, 1.00 mm?2 conductor
size. The wall plug must be a two-pole grounding type with a Japanese
Industrial Standard C8303 (7 A, 125 V) configuration.
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Power Cord Set Requirements

3-Conductor Power Cord Set Requirements (Continued)

Country/Region Accredited Agency Applicable Note Number
Korea EK 4
The Netherlands KEMA 1
Norway NEMKO 1
People’s Republic CcccC 5
of China

Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
United Kingdom BSI 1
United States UL 2
N NOTES:

1

. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 1.0 mm?

conductor size. Power cord set fittings (appliance coupler and wall plug)
must bear the certification mark of the agency responsible for evaluation
in the country where it will be used.

. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG,

3-conductor. The wall plug must be a two-pole grounding type with a
NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

. The appliance coupler, flexible cord, and wall plug must bear a “T” mark

and registration number in accordance with the Japanese Dentori Law. The
flexible cord must be Type VCT or VCTF, 3-conductor, 1.00 mm2 conductor
size. The wall plug must be a two-pole grounding type with a Japanese
Industrial Standard C8303 (7 A, 125 V) configuration.

. The flexible cord must be Type RVV, 3-conductor, 0.75 mm?2 conductor size.

Power cord set fittings (appliance coupler and wall plug) must bear
the certification mark of the agency responsible for evaluation in the country
where it will be used.

. The flexible cord must be Type VCTF, 3-conductor, 0.75 mm? conductor

size. Power cord set fittings (appliance coupler and wall plug) must bear the
certification mark of the agency responsible for evaluation in the country
where it will be used.
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1394 port 1-11
A

arrow keys 1-13
audio troubleshooting 2-21
audio-in jack

location 1-8

pin assignments D-2
audio-out jack

location 1-8

pin assignments D-1

base enclosure
removal 5-40
spare part numbers 3-9,
3-26
battery bay 1-9, 1-18
battery light 1-7
battery pack
removal 5-6
spare part numbers 3-9,
3-26, 3-27, 5-5
battery release latch 1-18
Bluetooth module
removal 545
spare part number 3-5,
3-23, 5-45

Index

Bluetooth module cable
illustrated 3-17
removal 5-46

bottom components 1-18

Bracket Kit
contents 3—-26
spare part number 3-26

C
Cable Kit
components 3—17
spare part number 3-5,
3-17, 3-26
cables, service considerations
4-2
caps lock key 1-13
caps lock light 1-15
CMOS clearing 14
components
bottom 1-18
front 1-6
keyboard 1-12
left-side 1-9, 1-10
right-side 1-8
top 1-14, 1-16
computer feet
illustrated 3-16
locations 5-10
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Computer Setup
Advanced Menu 2-5
Diagnostics Menu 2—4
File Menu 2-2
overview 2—1
Security Menu 2-3

computer specifications 6—1

connector pin assignments
audio-in D-2
audio-out D-1
external monitor D—4
headphone D-1
microphone D-2
modem D-5
monitor D—4
network D—6
RJ-11 D-5
RJ-45 D-6
S-Video-out D-3
Universal Serial Bus (USB)

D-2
connectors, service
considerations 4-2

design overview 1-20
disassembly sequence chart
5-3
diskette drive
OS loading problems 2—19
precautions 4-3
display assembly
removal 5-26
spare part numbers 3-3,
3-27, 3-29, 5-26
specifications 6-3

Display Cable Kit, spare part
number 3-15, 3-29, 5-30
Display Hinge Kit
components 5-30
spare part number 3—-15,
3-26, 5-30
display hinge, removal 5-38
display inverter board
removal 5-35
spare part number 3-15,
3-26, 5-30, 5-35
Display Label Kit, spare part
number 3-15, 3-29, 5-30
display panel
removal 5-35
spare part numbers 3-15,
3-26
Display Panel Kit, spare part
numbers 3-15, 3-26, 5-30,
5-35
Display Plastics Kit
components 3—15, 5-30
spare part number 3-15,
3-26, 5-30
display release button
assembly, spare part number
3-3,3-27
display release button, location
1-7
display release hook, removal
5-37
Display Screw Kit, spare part
number 3-15, 3-26, 5-30
drive light 1-7
drives, preventing damage 4-3
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Index

DVB-T TV tuner antenna,
spare part number 3-29
DVB-T TV tuner, spare part
number 3-28
DVD/CD-RW Combo Drive
precautions 4-3
specifications 6-6
DVD/CD-RW Double-Layer
Combo Drive
spare part numbers 3-29
DVD+RW and CD-RW
Combo Drive
precautions 4-3
spare part numbers 3-5,
3-19, 5-18
specifications 6—8
DVD-ROM drive
spare part number 3-5,
3-19, 5-18
spare part numbers 3-29

E
electrostatic discharge 44,
4-8
expansion port 2 1-11
expansion port 2 bracket
removal 5-65
spare part number 37,
3-27
expansion product
troubleshooting 2—14
ExpressCard assembly
removal 5-72
spare part number 3-5,
3-26, 5-72
ExpressCard slot 1-8

ExpressCard slot bezel 3-16
external monitor port
location 1-10
pin assignments D—4

F
f1 to f12 keys 1-13
fan assembly
removal 5-61
spare part number 3-7,
3-28, 5-61
features 1-2
feet
illustrated 3-16
locations 5-10
flowcharts, troubleshooting
no audio 2-21, 2-22
no network/modem
connection 2—26
no OS loading 2-15
no OS loading from
diskette drive 2-19
no OS loading from hard
drive 2-16, 2-17, 2-18
no OS loading from optical
drive 2-20
no power 2-8, 2—-10, 2-11
no video 2-12, 2-13
nonfunctioning device
2-23
nonfunctioning docking
device 2—-14
nonfunctioning keyboard
2-24
nonfunctioning pointing
device 2-25
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Index

fn key 1-13
front components 1-6

G

grounding equipment and
methods 4-7

H
hard drive
OS loading problems 2—16
precautions 4-3
removal 5-7
spare part numbers 3-9,
3-19, 3-28, 3-29, 5-7
specifications 6—4
hard drive bay 1-19
hard drive cover
illustrated 3—16
removal 5-7
headphone jack
location 1-8
pin assignments D—1
headset, spare part number
3-21, 3-23
heat sink, spare part number
3-7,3-23
HP remote control, spare part
number 3-20

|

I/0 address specifications
6-12

interrupt specifications 610

K

keyboard
removal 5-23
spare part numbers 3-3,
3-27,5-23
troubleshooting 2-24
keyboard components 1-12
keypad keys 1-13

L
labels area 1-18
LED board
removal 5-59
spare part numbers 3-3,
3-28, 5-59
left-side components 1-9,
1-10

M

mass storage devices, spare
part numbers 3-18
memory map specifications
6-15
memory module
removal 5-11
spare part numbers 3-9,
3-28, 5-11
Memory Reader 1-11
Memory Reader light 1-11
memory/Mini Card module
compartment cover
illustrated 3-16
location 1-19
removal 5-12
microphone jack
location 1-8
pin assignments D-2
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Index

Mini Card module
removal 5-14
spare part numbers 3—11,
3-13, 3-24, 3-25, 3-28,
5-14
modem connector cable
illustrated 3—17
removal 5-50
modem jack
location 1-8
pin assignments D-5
modem module
troubleshooting 2-26
monitor port
pin assignments D—4

network jack

location 1-11

pin assignments D—6
network, troubleshooting 2-26
nonfunctioning device,

troubleshooting 2-14, 2-23

num lock key 1-13
num lock light 1-15

o

optical drive
location 1-8, 1-18
OS loading problems 2-20
precautions 4-3
removal 5-18
spare part numbers 3-5,

3-19, 5-18

specifications 6-6

P

packing precautions 4-5
password clearing 14
PC Card assembly
removal 5-69
spare part number 3-5,
3-26, 5-69
PC Card slot 1-11
PC Card slot bezel, illustrated
3-16
plastic parts 4-2
Plastics Kit
components 3—-16
spare part number 3-7,
3-16, 3-26
pointing device,
troubleshooting 2-25
power button 1-15
power connector 1-8
power connector cable
illustrated 3—17
removal 549
power cord
set requirements E-2
spare part numbers 3-22,
3-23
power light 1-7
power management features
1-5
power supply, spare part
number 3-22, 3-23
power, troubleshooting 2—8
precautions
DVD/CD-RW Combo
Drive 4-3
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Index

DVD+RW and CD-RW
Combo Drive 4-3

hard drive 4-3

optical drive 4-3

processor

removal 5-67

spare part numbers 3-7,
3-25, 3-29, 3-30, 5-67

R
remote control, spare part
number 3-20
removal/replacement
preliminaries 4—1
procedures 5-1
right-side components 1-8
RJ-11 jack
location 1-8
pin assignments D-5
RJ-45 jack
location 1-11
pin assignments D-6
RTC battery
removal 5-17
spare part number 3-9,
3-26, 5-17
Rubber Pad Kit, spare part
numbers 3-26

S

Screw Kit
contents A—1
spare part numbers 3—15,
3-21, 3-28, A-1
screw listing A—1
SD Memory Card, spare part
numbers 3-9, 3-23, 3-24

security cable slot 1-10
serial number 3—1, 5-2
service considerations 4-2
speakers
location 1-7
removal 5-54
spare part number 3-9,
3-26, 5-54
specifications
computer 6—1
display assembly 6-3
DVD/CD-RW Combo
Drive 6-6
DVD+RW and CD-RW
Combo Drive 6-8
hard drive 64
1/0 addresses 6—12
interrupts 6-10
memory map 6-15
optical drive 6-6
system DMA 6-16
static shielding materials 4-8
S-Video-out jack
location 1-10
pin assignments D-3
switch cover
removal 5-21
spare part number 3-3,
3-26, 5-21
system board
removal 547
spare part number 3-25,
5-47
spare part numbers 3-7,
3-29

Index-6

Maintenance and Service Guide



Index

system DMA 6-16
system memory map 6—15

T
thermal paste, replacement
5-66
tools required 4-1
top components 1-14, 1-16
top cover
spare part numbers 3-3
top cover, spare part number
3-26
TouchPad bracket
removal 5-57
spare part number 3-3,
3-26
TouchPad buttons 1-17
TouchPad cable
illustrated 3—17
removal 5-56
TouchPad horizontal scroll
zone 1-17
TouchPad vertical scroll zone
1-17
TouchPad, location 1-17
transporting precautions 4—5
troubleshooting
audio 2-21
Computer Setup 2-1
expansion product 2—-14
flowcharts 2—6
keyboard 2-24
modem 2-26
network 2-26
nonfunctioning device
2-14, 2-23

OS loading 2-15
overview 2-1
pointing device 2-25
power 2—8

video 2—12

U
Universal Serial Bus (USB)
port
location 1-8, 1-11
pin assignments D-2
unknown password 1-4
USB digital drive, spare part
number 3-19, 3-21, 3-23
USB travel mouse, spare part
number 3-21, 3-23
USB/audio board
removal 5-51
spare part numbers 3-9,
3-28
USB/audio board cable
illustrated 3—-17
removal 5-50

\'"

vent, locations 1-9, 1-19
video troubleshooting 2—12
volume buttons 1-15
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w
Windows applications key
1-13

Windows logo key 1-13

wireless antenna
disconnecting 5-16, 5-27
spare part number 3-15,

3-28, 5-30
wireless button 1-15
workstation precautions 4-6
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